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PREFACE 
 
 

 

Dear Students, 

 

Microsoft Excel is a spreadsheet application which is capable of performing 

calculations, analyzing data and integrating information from different programs. 

 

This E-Book covers in-depth lessons on how to use various Excel 

formulas, Tables and Charts for managing small to large scale business process. 

It has been designed for computer users who would like to learn Microsoft Excel 

in easy and simple steps. 

 

If this E-Book helps anyone to learn and to use the computer effectively, 

it will be of great success. 
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Microsoft Office Excel 2007 

 
Microsoft Excel, the spreadsheet component of Microsoft Office, is created for performing 
mathematical calculations on the data and provides tools you need for your data analysis 
and calculations.  
Modern day analysis is heavily dependent on financial analysis. Spreadsheets are also 
utilized in numerous business applications like payroll, production planning, investment 
analysis and many other purposes.  
The default extension of Microsoft Office Excel 2007 file called Workbook is “.xlsx”. It is a 

major revision of Microsoft Office Excel after Microsoft Office Excel 2003. We no longer 
use the Menu driven part but that is replaced by Tab Tabbed Ribbons instead. To utilize 
the full features of Microsoft Office Excel, .net Framework of Microsoft should be installed. 

 
Features of Excxel  
Excel has the following features 

 Best fit


 Auto fill


 Comments


 Data form


 Sorting


 Macro Tools


 Goal Seek


 Scenario


 Formatting


 Charts
 
 

Terminology:  
Spreadsheet or Worksheet  

A spreadsheet or worksheet consists of rows and columns of the cells. The rows 
are usually identified by row numbers and the column name by letters. The majority of the 
screen is a blank area. Extensive data presentation features are standard in most 
spreadsheets, which include report generation and powerful graphing capabilities. 
Microsoft Office Excel 2007 has by default three worksheets present namely Sheet1, 
Sheet2, Sheet3 respectfully. We can add more sheets to it based on our need. 

 
Workbook  

A workbook is a container that holds one or more worksheets. That way a 
workbook can keep all the sheets related to a particular project in one file.  
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Rows and Columns  
Columns run up and down (Vertical) and Rows run side to side (Horizontal) in a 
spreadsheet. 

 
Cells  
The intersection of a row and a column generates a cell identified by the cell number. For 
example, row 5 when intersects column V, the cell we get is V5. 

 
Getting Started  
To start MS Office Excel 2007  
Click on Start > All Programs > Microsoft Office > Microsoft Office Excel 2007 

or  
Click on Start > Run > Type “Excel “ and Click on “OK” Button.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Microsoft Office Excel 2007 Interface 

 
Inserting a new worksheet  
Click on the icon next to Sheet 3 and we get a new worksheet called Sheet 4  
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Three default Sheets of a workbook 
 

Renaming/ Deleting a Worksheet  
Right click on the Sheet tab of which you want to Rename/Delete, scroll to 
Rename/Delete and click on it.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Insertion of a new Row/Column 
Right Click on the worksheet > Insert  
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The Insert Dialog Box appears  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Click on the Entire row/Entire column to insert new Row/Column>OK 

 
Deletion of Cells:  
Right Click on the Row/Column to be deleted > Delete 
The Delete Dialog Box appears  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Click on the Entire row/Entire column to delete Row/Column>OK  
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Opening a Workbook:  
Click on the Office button > Open. The open Dialog box Appears. Browse the location 

of the Workbook and Click on “Open “ button of the File Open Dialog box.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Saving a Workbook:  
Click On Office Button > Save. The save As dialog Box appears. Give the name of 
the Workbook and Click on Save button.  
If you want to save the workbook in older versions of Office excel, click on Office 
Button > Save As > “Excel 97-2003 Work Book” > Give the Name of the 
workbook and click on “Save” Button.  
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RELATIVE & ABSOLUTE ADDRESSING 
 

There are different sorts of cell references. These are: 
 Relative
 Absolute
 Mixed

 
A relative reference will change column and row numbers as it is copied to other 

cells. Think of it as an original instruction being to go in a certain direction e.g. 

2 rows up and 2 columns across from your current position. When this 

instruction is copied elsewhere, it will still refer to 2 rows up and 2 columns 

across from your new current position. 
 

An absolute reference is one that does not change. If you refer to a cell in a 

certain row and column and then copy that reference elsewhere, it will still refer 

to exactly the same cell or range. 
 

A mixed reference is one that is half relative and half absolute. 
 

An absolute address is defined with the use of the “$” symbol. This can be typed 

in at the time of creating the formula, or by editing the cell afterwards. 
 

Examples of relative and absolute addressing: 
 

Relative A4 A4:B5 
   

Absolute $A$4 $A$4:$B$5 
   

Mixed $A4 or A$4 $A4:B$5 
   

 
The “$ ” sign can be hand typed or inserted by pressing the keyboard shortcut 

F4. As you press F4 the cell address will cycle between the four variations of 

an address – for example A4 would cycle between: 
A4 
$A4 
A$4 
$A$4  

 
 

 



 

 

 
 
 
 
 
 

 
MS Excel 2007 11 

 

PASTE SPECIAL AND TEXT TO COLUMNS 
 

Using the Cut, Copy, and Paste commands in Excel, you can move or copy entire 

cells or their contents. You can also copy specific contents or attributes from the 

cells. For example, using Paste Special you can copy the resulting value of a 

formula without copying the formula itself, or you can copy only the formula. 
 

Using the Paste Special Dialog Box  
The Paste Special dialog box allows you to select which aspects of the copied 
data you would like to paste.  

1. Select the cell(s) whose values should be copied. These cells have a 
function as well as the value inside  

2. Press [Ctrl] + [C] 
or 

From the Home command tab, click COPY 
3. Select the cell(s) where the results should be pasted. From 

the Home command tab, click the PASTE>Select Paste Special 
or 

Press [Ctrl] + [V]>Select Paste Special  
 

The Paste Special dialog box appears. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

1. Select the desired options 

EXAMPLE: To paste only the results of a formula, Select Values 
2. Click OK. The results of the formula are pasted into the selected cell(s). 
Paste Special Options 
You may choose to paste many different aspects of your copied data. 

1. All: pastes all information in the copied cell; this is the default option  
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2. Formulas: paste only the formula from the selected cell  
NOTE: Any relative cell references within the formula are changed to reflect its 
new location. 
3. Values: paste only the result of the formula from the selected cell 
4. Formats: paste only the formatting applied to the cell (e.g., font or color 
of the text)  
5. Comments: paste only annotations that were made to the cell 
6. Validation: pastes any rules about what text can be entered in the cell 
(e.g., only numbers between 1 and 25) 
7. All except borders: paste the formatting and contents of the cell, 
excluding any cell borders  
8. Column widths: paste only the width of the selected column 
9. Formulas and number formats: paste the formula from the selected cell and 

any formatting applied to numbers (e.g., number of decimal places displayed) 

10. Values and number formats: paste the numerical result of the formula 
from the selected cell, as well as any formatting applied to numbers (e.g., 
number of decimal places displayed)  
11. None: the values that are being pasted override any data already in the 
destination cells; this is the default option 
12. Add the values that were copied to the data in the destination cells 
13. Subtract the values that were copied from the data in the destination cells 
14. Multiply the values that were copied by the data in the destination cells 
15. Divide the values that were copied by the data in the destination cells 
16. Skip blanks paste the contents of all cells except for empty cells  
NOTE: This option is only useful when pasting a range of cells into an area that 
already contains information. This will ensure that a blank cell will not be pasted 
in place of information that is already in place.  
17. Transpose causes information that extended down a column to extend 
across rows and vice versa  
NOTE: If you select more space for the information to be pasted into than you 
have cells to be pasted, the information will be repeated to fill the selected 
space. For example, if you copy one column and paste it into four rows while 
using Transpose, the information from the column will be repeated in every row.  
18. All using Source theme: when using a document theme, pastes all 
information using formatting from the theme that was applied to the copied cells  
19. Paste Link: connects the cells that were copied with the pasted cells; if the 
data in one group changes, so will the data in the other group 
A. Paste Special 

1. Copy the names from cells 
i. These cells have a function as well as the value inside 

2. Paste only the values 
i. Select cell  
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ii. On the Ribbon >select the Home tab>in the 

Clipboard group>click the Paste down arrow >in 

the menu choose Paste Values 
iii. Clear the information in cells 

 

B. Text to Columns  
1. Select cells 
2. On the Ribbon >select the Data tab>in the Data Tools 

group>click Text to Columns 
3. In the Convert text to columns wizard window 

i. Select the radio button next to Delimited 
ii. Choose the Next >button 
iii. Under Delimiters check  only the Space box 
iv. Choose the Next >button 
v. Choose the Finish button  
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NAMING CELLS AND RANGES 
 

Cells and ranges can be given a name so that when you need to refer to that cell 

or range of cells, you can refer to its name rather than an address. 
Traditional cell addresses have been used for working out January‟s profit or loss.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Row 6 has been given the name Total_Income and Row 15 the name 

Total_Expenditure. When the formula for February was done, the syntax was 

Total_Income–Total_Expenditure.  
Using names may make it easier to understand what the formula is doing–it 
might make more sense to some, than saying B6–B13.  
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There are a couple of ways to create a range name. They both require that you 

select the cell or range or before creating the name. 
 

Method 1: INSERT, NAME, DEFINE option (or CTRL + F3)  
1. Go to the INSERT, NAME, DEFINE dialog box (or press the keyboard 
shortcut CTRL + F3). The DEFINE NAME dialog box will appear;  
2. Give the cell or range you selected a name 
3. Click on ADD, and then click on CLOSE. 

 
 Range names must be one word – if you require 2 words, join them with an 

under score as in the example below.

 The names can be a combination of numbers and letters, but must not 
start with a number.

 The default is to show the address as being ABSOLUTE. By clicking in the 
REFERS TO text box, this can be edited to what is required. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 As a default, names are work book level i.e. the name you create is 

available throughout the whole work book.

 If the worksheet has been named with a name that includes spaces, the 
worksheet name will have to be enclosed in single quotation marks.

 

Method 2: Using the NAME box 
1. Highlight the cell or range(s) that is going to be named; 
2. Click in the NAME box. The contents of the name box will be highlighted; 
3. Type the RANGE NAME you want and ENTER to accept the name.   
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Applying a Range Name in a Formula 
To use the RANGE NAME in a formula either:  
1. Type the name – make sure you use the correct spelling or else the 

function will not recognize the name; or  
2. When you are in the part of the formula that requires the RANGE NAME, 

press the keyboard shortcut F3. This brings up the PASTE NAME dialog 
box. Select the name and click on OK.  
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When working with many names, you can have a list of these names and the cells 

or ranges they refer to be placed in your workbook by using the PASTE LIST 

option (located in the PASTE NAME dialog box). Make sure you are in an empty 

cell and have 2 columns free and as many rows as there are names before using 

this option. The first column will list the RANGE NAMES, the second column 

shows the range address that the range name refers to.  
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USING NAMES FOR CONSTANTS OR FORMULAS 
 

In addition to using Names to name cells or ranges, you can also name constants 

or formulas, these constants or formulas don‟t have to appear in a cell. This is a 

good way of storing a constant or a formula that may have to be used several 

times. 
 

Naming a constant  
Imagine having to work out someone‟s holiday leave loading. You might have the 
leave loading in a cell (H6 in the example below), so that you can use this value 
in a formula. By having the value in a separate cell, if the leave loading rate ever 
changes you would only have to change the value in H6 and all formulas 
referring to this cell would update. 

 
The formula in this case is =(D5/52)*4*$H$6 , i.e. the salary divided by 52 

weeks, multiplied by 4 weeks and then multiplied by 17.5%.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

By using a name in the formula rather than a cell address, you save space in the 

spreadsheet and make the formula more readable i.e. what is easier to read 

=(D5/52)*4*$H$6; or 
=(D5/52)*4*loading  
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To give the leave loading of 17.5% (which is a constant) a name, you:  
1. Open the DEFINE NAME dialogbox (INSERT, NAME, DEFINE or CTRL+F3).  

2. Give the constant a name i.e. Loading  
3. In the REFERS TO: section enter the amount of the constant 

(without an “=” sign, Excel will add this in for you).  

4. Click on ADD, then CLOSE to close the DEFINE NAME dialogbox.  
5. When creating the formula, use F3 when it is time to refer to the 

loading, select the name Loading and ENTER to accept the setting (or 

click on OK), then continue creating the formula in the normal way.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Naming a Formula  
Instead of referring to the leave loading to do the last bit of multiplying, why not 

put the whole part of working out the leave loading into one name? i.e. Take the 

cell containing the salary and multiply it by loading. The formula would look like: 
=Loading  
To name a formula you:  
1. Open the DEFINE NAME dialogbox (INSERT, NAME, DEFINE or CTRL+F3).  

2. Give the formula a name i.e. Loading  

3. In the REFERS TO: section  
 type an “=” sign to start off theformula



 open a left bracket”(“


 in the spreadsheet click on the cell containing the salary 
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 This cell address is ABSOLUTE (i.e. it says $D$5). Use the F4 key to make 

the reference relative i.e. D5. If you don‟t, when you copy the formula to all the 

other staff members, each formula will refer to Fred Smith‟ssalary.


 type/52)*4*17.5%


 The formula should read =(„NAMING FORMULAS‟!D5/52)*4*17.5% . If you 

use a new sheet it will look something like=(Sheet1!D5/52)*4*17.5% 
4. Click on ADD, then CLOSE to close the DEFINE NAME dialogbox.  

5. When creating the formula make sure you are in appropriate cell, then either:  
 use F3 to select the name „LOADING‟ and ENTER to accept the setting (or 

click on OK), ENTER again or click on the green–’to finish the formula; or


 Type = loading then ENTER or click on the green–’to accept. 
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REFERENCING OTHER WORKSHEETS AND WORKBOOKS 

Referencing Other Worksheets  
The easiest and most accurate way to reference a cell or range in another 

worksheet is to use the point method (i.e. physically go to the worksheet and 

select the cell or range whilst you are creating your formula). Excel then refers to 

that worksheet in the correct syntax which is the sheet name, followed by an 

exclamation mark (!), followed by the cell or range, e.g. Sheet1!A1:B4.  
 If the worksheet has been renamed, the name is used instead of the sheet 

and number, e.g. for a sheet that is named Budget it would be Budget! A1:B4.


 If the sheet name includes spaces, the sheet name must be enclosed within 

quotation marks, e.g. a sheet that is named Budget 2004 would be „Budget 

2004‟!A1:B4 
The following steps show how to use the pointing method to make a reference to 

another worksheet in a formula.  
1. Click in B7 on the sheet called “Budget”. An amount from the “Recurring 

Expenses” sheet is to go here.  
2. Type an equal sign (=). This tells Excel you are starting a function, at the same 

time it „anchors‟ you to this cell so that you can go to other worksheets or work 

books and be able to point at cell references in those worksheets/workbooks.  
3. Click on the Recurring Expenses sheet tab and click on B7, which is the 

total of recurring expenses.  
4. Press ENTER on the keyboard to finish the function off or if you prefer, click 

on the green –’next to the formula bar.  
The amount of the total recurring expenses is now placed in Cell B7 on the 
Budget sheet. Notice the formula in B7 reads=‟RecurringExpenses‟!B7  
1. Click in B8 on the sheet called “Budget”. A small formula that works out 5% 

of salary (located on the Recurring Expenses worksheet) is to go here. 

2. Type an equal sign (=) and then click on cell B11 on the Recurring 

Expenses sheet.  

3. Now type an asterisk (*) to multiply the total income by 5%. 

4. Type.05 (i.e.5/100) and press ENTER on the keyboard to click on the 

green– ’to finish the function (typing 5% will also work)  
Your functions hould read =‟Recurring Expenses‟!B11*0.05 or  
= ‟Recurring Expenses‟ !B11*5%  
Keep this workbook open for the “Referencing other Workbooks” example. 

Referencing other Workbooks  
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The easiest way to reference another workbook is to have that workbook open while 

you are making reference to it. If you do not have the workbook open you will have to 

type in the full name and path of the workbook when referring to it, which can be 

quite tedious. The syntax for referring to a worksheet is the name of the worksheet 

enclosed in square brackets, followed by the sheet name, an exclamation mark, then 

cell addresses or ranges. e.g. [worksheet.xls] Sheet1! Cellreference  
If the workbook name includes spaces, the workbook and sheet name must be 

enclosed within quotation marks, e.g. to refer to a cell in a workbook called 

“Yearly Expenses.xls” you would type: „[YearlyExpenses.xls]Sheet1‟!A]  
If the workbook you are referencing is closed at the time of building the function, 

you must include the full path name of the workbook.e.g.‟d:\excel files\[Yearly 

Expenses.xls]Sheet1'!A1  
By having the worksheet that you are working on, and the worksheet you are 

going to refer to open at the same time, you can use the point method to 

reference the worksheet. The following instructions place a reference in 

“Referencing other workbooks and sheets.xls” from the workbook “Yearly 

Expenses.xls”. These should be open at the same time: (Hint 

– use the WINDOW, ARRANGE command to place the worksheets side by side).  
1. In cell B14 of ”Referencing other workbooks and files”, type an equal sign 

(=) to start off a formula (which also anchors you to this cell while you go to 

another workbook).  
2. Either using the taskbar or the WINDOWS menu, go to the workbook called 

“Yearly Expenses”. Click in cell B4. (if you have arranged the worksheets side by 

side, this is where you can simply click in B4 of the Yearly Expenses workbook)  

3. To finish referring to this cell, press the ENTER key on the keyboard or use 

the green–’.  

Notice the syntax of the formula is:  =‟[Yearly expenses.xls]Sheet1'!$B$4  
Excel makes the cell or range reference ABSOLUTE when you point and click on 

another workbook. If you need to copy this to other cells you will need to change 

the reference so it is RELATIVE (no $ signs) 

4. Repeat for cells B15, B16 and B17 Hint: use the fill handle 

5. If you have both workbooks open, have a look at the syntax of this formula 

in the formula bar of the “Referencing other workbooks and sheets” window. Now 

close „Yearly Expenses.xls‟, click in cell B14 in „Referencing other workbooks and 

sheets‟ and have another look at the formula bar. The syntax has automatically 

changed to include the full pathname of the closed file, which as you can see is 

very long and would be awkward to type accurately.  

FILL HANDLE AND FILL SERIES COMMAND 

There are three ways to click and drag on a cell – each having a different effect.   
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When you have the mouse inside a cell, the cursor will be shaped like the Swiss 

Cross. If you click and drag when this symbol is showing you will select a range 

of cells.  
1. When you point to any border of a cell the cursor changes to a 4-sided 

arrow or an arrow. Clicking and dragging with this symbol will drag 
and drop the contents of the cell (to copy instead of move, hold down 
the CTRL key as you drag the contents of the cell).  

2. In the right-hand bottom corner of every cell there is a small square. If 
you hold the mouse above this, the cursor changes into a thick plus 
sign. In this mode, if you click and drag, you are using the FILL 
HANDLE to fill cells you drag over. 

 
If the fill handle is not showing, go to TOOLS, OPTIONS, EDIT and ensure the 

ALLOW CELL DRAG AND DROP option is enabled.  
The fill handle is a copying tool for copying formulas, and values; however it is 
also used to fill in a variety of series such as sequential numbers, dates and 
mixed text.  

This Entry Can be extended to 
  

1,2,3 4,5,6,7 etc 
  

January February, March, April etc 
  

Jan Feb, Mar, Apr etc 
  

Monday Tuesday, Wednesday, Thursday etc 
  

Mon Tue, Wed, Thu etc 
  

Qtr 1 Qtr2, Qtr3, Qtr4 
  

1 June 2 June, 3 June, 4 June etc 
  

01/04/04 02/04/04, 03/04/04, 04/04/04 etc. 
  

1st Period, 2nd Period, 3rd Period etc. 

9:00 AM 10:00 AM, 11:00 AM etc. 
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Using the Fill Handle 
 

Open a blank worksheet and try the following fill handle techniques:  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

A. Type a #1 in A1. Drag down to A12. You should end up with all number 

ones. This is because Excel has no idea you want to have a series, i.e.1, 

2, 3 etc. 
B. Type a #1 in B1. Hold down the CTRL key and drag down to B12. You 

now have a series. The CTRL key makes Excel do the opposite of its 
natural function when using the fill handle.  

C. Monday will drag down the days of the week 
D. The fill handle is case sensitive and will recognize abbreviations. 
E. Here the CTRL key was held down while dragging Monday, 

hence Excel did its opposite function.  
F. Type in a date. Drag down with the RIGHT mouse button. When you 

release the mouse, you can select different options from the shortcut 
menu. FILL MONTHS was selected in this example.  

G. To get a series such as this you need to give Excel a bit of a hand. In 
G1 type #5, in G2 type #10. Now select both these cells and drag down 
with the fill handle. Excel now recognizes the sequence.  

H. Finally, a trick which is handy especially if it is a very long list you have 
to drag. Type the first entry and then DOUBLE CLICK on the fill handle. 
The series will fill as far down as the column next to it, so this will not 
work if there isn‟t any data in the column nextdoor.  
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Using the Fill Series Command  
If you have a specialized or very long list, it may be more efficient to use 
the EDIT, FILL, SERIES option. 
If you had to have a column numbered 1 to 600, it would be quickertousethe 

EDIT, FILL, SERIES command. Another example is if you had to have a 

monthly date entered for 25 years (for a mortgage repayment schedule)  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The above Example shows having a column numbered from 1 to 600. 
1. Type a #1 in a blankcell. 
2. Click on EDIT, FILL,SERIES 
3. Select either ROW Sor COLUMNS (specifies where data will be 

filled– column is the more common). 
4. Excel recognizes #1 as being a number and therefore has 

automatically selected LINEAR.  
5. Make sure Step Value = 1, and Stop value =600  

6. Click on OK to finalize.  
Linear – will create a linear series based on the value you have entered on the 

worksheet. If the TREND option is cleared, Linear uses the value in the STEP 

VALUE text box. This value is the amount you want adding each time to the 

value you have on the worksheet – 1 would make it 1,2,3,4 etc. 2 would make 

it 1,3,5,7 etc). STOP VALUE is the value you want to stop at. 
 

If TREND is enabled, the STEP VALUE AND STOP VALUE are greyed out. In this 

scenario you would enter an example of the trend desired in 2 or more cells on the 

worksheet, then select all the cells which you want filling before going to the EDIT, 

FILL, SERIES command. For example, if you put #5 in cell A1, and #10 in cell A2, 

then select A1:A12, the result would be 5,10,15,20,25,30,35,40…..60.  
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Growth – will create a series whereby the number is multiplied by the number 

in the STEP VALUE. If you have #1 in cell A1, then go into EDIT, FILL, SERIES and 

select COLUMN, GROWTH, STEP VALUE = 2 and STOP VALUE = 20 the result 

would be 1,2,4,8,16. 
 

Customizing a Fill Series  
Any list of items that you use constantly can be made into a customized list. 
For example – a roster of staff members 

1. If you have a list typed, select the list. 
2. Click on TOOLS, OPTIONS, CUSTOM LISTS  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Click on the IMPORT button. The list you selected will 

appear in the LIST ENTRIES window.  
4. If you did not select a list before you entered this option, click in the 

LIST ENTRIES window and type in the list, using a new line for each 
entry. When you have finished adding items, click on the ADD button.  

5. Click on OK to finish. 
 

Deleting a Custom List 
1. Click on TOOLS, OPTIONS, CUSTOMLISTS  
2. In the CUSTOM LISTS window, select the list to be deleted 
3. Click on the DELETE button  
Click on OK to accept the warning that the list will be deleted and then OK 

again to close the CUSTOM LISTS window.  
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CONDITIONAL FORMATTING 
 

Conditional formatting is extremely useful for things like changing the color of 

cells or text in order to flag an event. Formatting occurs when a cell reaches 

the condition that is set in the Conditional Formatting option.  
Example1 If you are doing aroster, having cells that reach a certain date turn 
red. 

 
Example2 A spreadsheet that has student exam results – having those that 

Pass turn yellow in order to see who should receive a 

Distinction. You may also want to highlight the “Fail” marks in 

red so as to flag them for follow up. The instructions for doing 

this example are below. 
 

Creating a Conditional Format  
Steps 1-8 show how to make cells in Column D below change color if a student 
has passed (using 19 marks or over as the benchmark), (the formula will have 
to refer to the data in Column C to work this out). Steps 9-10 show how to 
make the score in Column C change color if a student has 10 marks or less (to 
show that they have failed).  

 
 
 
 
 
 
 
 
 
 
 
 

 

1. Click in the first cell that will have conditional formatting attached (D6)  
2. Click on FORMAT, CONDITIONAL FORMATTING. The 

CONDITIONAL FORMATTING dialog box willappear.  
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3. Change the first dialogue box to FORMULA IS. This allows you to enter 

the instructions to refer to another location other than the one you are 

currently in.  
4. The formula is the condition i.e. to find out if the figure to the left is 

greater than or equal to (>=) 19 . If you use the pointer to enter the 

cell address, make sure you change it to relative (as a default Excel will 

make it Absolute).  

5. Click on the FORMAT button 

6. In the FORMAT CELLS dialogue box that appears, make all the required 

changes. In the example being used here you would choose the 

PATTERNS tab, and then choose a yellow fill color for the cell.  

7. Click on OK (twice) to finalize the formatting. 

8. To copy the formatting to the rest of the cells in the column either: 

use the FORMAT PAINTER  
 use the fill handle (use this only if the cell contains a formula) to copy 

to the other cells – beware - if you use the fill handle on cells 

containing values, you will change the values; or  
 use the normal COPY command and then use the EDIT, PASTE SPECIAL, 

FORMATS option to apply to the other cells  
9. To apply conditional formatting to an active cell (in our example, 

changing the cell to red if the student has 10 or less marks) - place the 

cursor in Cell C6. Click on FORMAT, CONDITIONAL FORMATTING  
10. Select CELL VALUE IS (this will make Excel look at the value of the cell 

you are currently placed in). Make the changes the same as below (the 

fill color is red). Click on OK to finish, and then copy the formatting to 

the rest of the column as previously described.  
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Should you require more than one condition, click on the ADD button.Ifyouwant 

to get rid of a condition, select the DELETE button and then specify which 

condition is to beerased. 
 

Find cells that have conditional formats  
To find all cells that have conditional formatting, click any cell in the worksheet 
then follow the steps 1-3below.  
To find cells that have conditional formatting settings identical to the settings of 
a specific cell, click the specific cell, and then do steps 1-4 below. 

1. On the EDIT menu, click GOTO. 
2. Click on the SPECIAL button. 
3. Select the CONDITIONAL FORMATS option. 
4. To find cells with identical conditional formats, click SAME below DATA 

VALIDATION (the default is ALL).  
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TABLES 
 

A table is made up of columns and rows. Where they intersect, a cell is created. 

When you create a table in Excel, you can manage and analyze the data in that 

table independently of data outside of the table. For example, you can filter table 

columns, add a row for totals, apply table formatting, and apply a style to a 

word, line, or paragraph 
A. Insert a table  

1. Select the cell range 
2. On the Ribbon, select the Insert tab>in the Tables group >click 

Table 
3. In the new window under Where is the data for your table? Make 

sure the range is the same as the one you selected  
4. Check the box to the right of My table has headers 
5. Click OK 

 

B. Table design  
1. The Design tab is now showing on the Ribbon 

 

C. Table expansion  
1. One of the great options with using a table format is that you can 

expand the table  
i. Move your mouse pointer to the bottom right corner of the 

table and use the Fill Handle to click and drag to the right 
and down  

ii. Notice how the added cells change their look and feel to 
match the table  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



 

 

 
 
 
 
 
 

 
MS Excel 2007 31 

 

CHART 
 

The Charts are used to give a graphical touch to the written data. It is very useful 

for analyzing and understanding them very quickly.  
In Microsoft Excel, you can represent numbers in a chart. On the Insert tab, you 
can choose from a variety of chart types, including column, line, pie, bar, area, 
and scatter. The basic procedure for creating a chart is the same no matter what 
type of chart you choose. As you change your data, your chart will automatically 
update. You select a chart type by choosing an option from the Insert tab‟s Chart 
group. After you choose a chart type, such as column, line, or bar, you choose a 
chart sub-type. For example, after you choose Column Chart, you can choose to 
have your chart represented as a two -dimensional chart, a three-dimensional 
chart, a cylinder chart, a cone chart, or a pyramid chart. There are further sub-
types within each of these categories. As you roll your mouse pointer over each 
option, Excel supplies a brief description of each chart- 

 

Create a Chart  
 
 
 
 
 
 
 
 
 
 
 

 

To create the column chart shown above, start by creating the worksheet below 

exactly as shown.  
 
 
 
 
 
 
 
 
 
 
 

 

After you have created the worksheet, you are ready to create your chart.  
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EXERCISE 1 
 

Create a Column Chart  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. Select cells A3 to D6. You must select all the cells containing the data you 

want in your chart. You should also include the data labels. 
 

2. Choose the Insert tab. 
 

3. Click the Column button in the Charts group. A list of column chart sub-

types appears. 
 

4. Click the Clustered Column chart sub-type. Excel creates a Clustered 

Column chart and the Chart Tools context tabs appear. 
 

Apply a Chart Layout  
Context tabs are tabs that only appear when you need them. Called Chart Tools, 

there are three chart context tabs: Design, Layout, and Format. The tabs become 

available when you create a new chart or when you click on a chart. You can use 

these tabs to customize your chart. 
 

You can determine what your chart displays by choosing a layout. For example, 

the layout you choose determines whether your chart displays a title, where the 

title displays, whether your chart has a legend, where the legend displays, 

whether the chart has axis labels and so on. Excel provides several layouts from 

which you can choose.  
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1. Click your chart. The Chart Tools become available. 
 

2. Choose the Design tab. 
 

3. Click the Quick Layout button in the Chart Layout group. A list of chart 

layouts appears. 
 

4. Click Layout 5. Excel applies the layout to your chart. 
 

Add Labels  
When you apply a layout, Excel may create areas where you can insert labels. You 

use labels to give your chart a title or to label your axes. When you applied layout 

5, Excel created label areas for a title and for the vertical axis.  
 
 
 
 
 
 
 
 
 
 
 
 

 

Before After  
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1. Select Chart Title. Click on Chart Title and then place your cursor before 

the C in Chart and hold down the Shift key while you use the right arrow 

key to highlight the words Chart Title. 
 

2. Type Toy Sales. Excel adds your title. 
 

3. Select Axis Title. Click on Axis Title. Place your cursor before the A in 

Axis. Hold down the Shift key while you use the right arrow key to 

highlight the words Axis Title. 
 

4. Type Sales. Excel labels the axis. 
 

5. Click anywhere on the chart to end your entry. 
 

Switch Data  
If you want to change what displays in your chart, you can switch from row data 

to column data and vice versa.  
 
 
 
 
 
 
 
 
 
 
 
 
 

Before After 
 

1. Click your chart. The Chart Tools become available. 
 

2. Choose the Design tab. 
 

3. Click the Switch Row/Column button in the Data group. Excel changes the 

data in your chart. 
 

Change the Style of a Chart 
A style is a set of formatting options. You can use a style to change the color and 
format of your chart. Excel 2007 has several predefined styles that you can use. 
They are numbered from left to right, starting with 1, which is located in the 
upper-left corner.  
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1. Click your chart. The Chart Tools become available. 
 

2. Choose the Design tab. 
 

3. Click the More button in the Chart Styles group. The chart styles 

appear.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

4. Click Style 42. Excel applies the style to your chart.  
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Change the Size and Position of a Chart  
When you click a chart, handles appear on the right and left sides, the top and 

bottom, and the corners of the chart. You can drag the handles on the top and 

bottom of the chart to increase or decrease the height of the chart. You can drag 

the handles on the left and right sides to increase or decrease the width of the 

chart. You can drag the handles on the corners to increase or decrease the size 

of the chart proportionally. You can change the position of a chart by clicking on 

an unused area of the chart and dragging.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

1. Use the handles to adjust the size of your chart. 
 

2. Click an unused portion of the chart and drag to position the chart beside 

the data. 
 

Move a Chart to a Chart Sheet  
By default, when you create a chart, Excel embeds the chart in the active worksheet. 

However, you can move a chart to another worksheet or to a chart sheet. A chart 

sheet is a sheet dedicated to a particular chart. By default Excel names each chart 

sheet sequentially, starting with Chart1. You can change the name.  
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1. Click your chart. The Chart Tools become available. 
 

2. Choose the Design tab. 
 

3. Click the Move Chart button in the Location group. The Move Chart dialog 

box appears.  
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4. Click the New Sheet radio button. 
 

5. Type Toy Sales to name the chart sheet. Excel creates a chart sheet 

named Toy Sales and places your chart on it. 
 

Change the Chart Type  
Any change you can make to a chart that is embedded in a worksheet, you can 
also make to a chart sheet. For example, you can change the chart type from a 
column chart to a bar chart.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. Click your chart. The Chart Tools become available. 
 

2. Choose the Design tab. 
 

3. Click Change Chart Type in the Type group. The Chart Type dialog box 

appears. 
 

4. Click Bar. 
 

5. Click Clustered Horizontal Cylinder.  

6. Click OK. Excel changes your chart type.  
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EXERCISE 2 
 

Create a Pie Chart  
The steps below will create a basic pie chart. Select the Data  

 Click on the Insert >Pie>Select the Style
 

ADDING THE CHART TITLE  
Edit the default Chart Title by clicking on it twice - but don‟t double click  

1. Click once on the default chart title to select it - a box should appear 

around the words Chart Title  
2. Click a second time to put Excel in edit mode, which places the cursor 

inside the title box  

3. Delete the default text using the Delete/Backspace keys on the keyboard  

4. Enter the chart title into the title box 
 

ADDING THE DATA LABELS 
1. Click once on the pie chart in the plot area to select it  

2. Right click on the chart to open the data series context menu  
3. In the context menu, hover the mouse above the Add Data Labels option 

to open a second context menu  
4. In the second context menu, click on Add Data Labels to add the values 

for each School- to each slice of pie in the chart  
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CHANGING THE COLOR OF THE PIE SLICES 
1. Click on the chart background to select the entire chart  
2. Click on the Change Colors option located on the left hand side of 

theDesign tab of the ribbon to open a drop down list of color choices  

3. Hover your mouse pointer over each row of colors to see the option name  
4. Click on the Color 5 option in the list - the first choice in 

theMonochromatic section of the list  

5. The slices of pie in the chart should change to varying shades 
 

CHANGING THE CHART‟S BACKGROUND COLOR  
Formatting the background is a two-step process because a gradient is added to 

show slight changes in color vertically from top to bottom in the chart.  
1. Click on the background to select the entire chart  

2. Click on the Format tab of the ribbon  

3. Click on the Shape Fill option to open the Fill Colors drop down panel  
4. Choose Blue, Accent 1, Darker 25% from the Theme Colors section of the 

panel to change the chart‟s background color to dark blue  
5. Click on the Shape Fill option a second time to open the Colors drop 

down panel  
6. Hover the mouse pointer over the Gradient option near the bottom of the 

list to open the Gradient panel  
7. In the Dark Variations section, click on the Linear Up option to add a 

gradient that gets progressively darker from bottom to top 
 

CHANGING THE TEXT COLOR  
Change the color of all text in the chart to white  

1. Click on the background to select the entire chart  

2. Click on the Format tab of the ribbon if necessary  

3. Click on the Text Fill option to open the Text Colors drop down list  

4. Choose White, Background 1 from the Theme Colors section of the list  

5. All the text in the title and data labels should change to white  
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ADDING CATEGORY NAMES AND MOVING THE DATA LABELS 
This step will add the name of each School to the data labels along with the value 
that is currently displayed. It will also ensure that the data labels are displayed 
inside the chart so there will be no need to display leader lines linking the label 
to its respective slice of the pie chart.  
1. Click once on one of the data labels in the chart - all data labels in the chart 
should be selected  

2. Click on the Format tab of the ribbon if necessary  
3. Click on the Format Selection option on the left side of the ribbon to open the 
Formatting Task pane on the right side of the screen  
4. If necessary, click on the Options icon in the pane to open the label options 
5. Under the Label Contains section of the list, add a check mark to theCategory 
Name option to display the School names as well as their Percentage, and remove 
the check mark from the Show Leader Lines option  
6. Under the Label Position section of the list, click on the Inside end to move all 
data labels to the outer edge of their respective sections of the chart 

 

CHANGING THE FONT TYPE AND SIZE  
Changing the size and type of font used in the chart, will not only be an 

improvement over the default font used in the chart, but it will also make it 

easier to read the category names and data values in the chart. 
 

Note: The size of a font is measured in points - often shortened to pt. 
 

72 pt text is equal to one inch - 2.5 cm - in size.  
1. Click once on the chart‟s title to select it  

2. Click on the Home tab of the ribbon  
3. In the font section of the ribbon, click on the Font box to open the drop 

down list of available fonts  
4. Scroll to find and click on the font Lucida Sans Unicodein the list to 

change the title to this font  

5. In the Font Size box next to the font box, set the title font size to 16 pt  

6. Click once on the data labels in the chart to select all four labels  

7. Using the steps above, set the data labels to 8 pt Lucida Sans Unicode  
EXPLODING A PIECE OF THE PIE CHART  
This last formatting step is to drag or explode the St. Mary‟s slice out from the 

rest of the pie to add emphasis to it.  
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After exploding out the St. Mary‟s slice, the rest of the pie chart will shrink in 

size to accommodate the change. As a result, it may be necessary to reposition 

one or more of the data labels to place them fully inside their respective sections.  
1. Click once on the pie chart in the plot area to select it  
2. Click once on the St. Mary‟s slice of the pie chart to select just that 
section of the chart - make sure that only the St. Mary‟s slice is surrounded by 
the small blue highlight dots  
3. Click and drag the St. Mary‟sslice out from the pie chart to explode it 
4. To reposition a data label, click once on the data label - all data labels 
should be selected  
5. Click a second time on the data label to be moved and drag it to the 
desired location  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



 

 

 
 
 
 
 
 

 
MS Excel 2007 43 

 

Operators 
 

Operators are those which works on operands. For example A + B. Here A and B 

are the operands and + is the operator. Based on the type of operations we can 

have grouping of these operators:  
1. Arithmetic Operators: To perform basic mathematical operations such as 

addition, subtraction, divisions, multiplications, etc, we use arithmetic 
operators.  
Arithmetic Operators Meaning Example 

+ Addition 3+3 
- Subtraction 6-4 
* Multiplication 5*9 

- (Negation) Unary negative operator -89 
/ Division 45/8 
% Percent 20% 

^ (Caret) Exponentiation 3^2=9 means 32 
 

2. Comparison Operators: We can compare two values with comparison 
operators such as are they equal, greater less than the operand with 
whom we are comparing them. When we compare two operands, the 
result is always in either true or false.  
Comparison Operator Meaning Example 

= Equal to A1=B1 
> Greater than C1>C5 

>= Greater than equal to B1>=E1 
< Less than M2<H4 

<= Less than Equal to D5<=D10 
<> Not equal to H1<>H2 

 

3. Text Concatenation Operator: We use & ( ampersand operator) to join or 
concatenate one or more strings. Example : “north” & “Wind” will give the 
result as “northWind”. 

 

4. Reference Operators: Combines range of cells for calculations with the 

following operators: 
 

Reference Operator Meaning Example 
: Range Operator, which provides a range of B1:B10 

 all the cells in between two given cells.  

, Union operator, which combines multiple =Sum(B1:B5, C3:C10) 
 references into one reference.   
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THE FUNCTION WIZARD 
 

A function is inserted into a spreadsheet either by typing it directly into the 

active cell; or in the formula bar; or by using the INSERT FUNCTION option in 

Excel. The latter automates the process, ensuring that you get arguments in 

the right order. 
There are several ways of accessing the INSERT FUNCTION dialog box: 

 Use the INSERT menu, select the FUNCTION option;

 Use the shortcut – SHIFT + F3; or
 Click on the INSERT FUNCTION icon next to the formula bar. 

 
 
 
 
 
 
 
 
 
 
 
 
 

Using the Function Wizard  
1. Make sure you are in the cell where you want to place a function, and 

then open the INSERT FUNCTION dialog box by one of the methods 
listed above.  

2. The INSERT FUNCTION dialog box will appear.  
 
 
 
 
 
 
 

a  
b 

 
c 

 
 
 

 
d  
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a) Type a brief description of what you want to do – then click on GO. Excel 

will search for functions that might perform the job;or  
b) If you prefer, and if you know the name of the function, you can drop 

down a list and select a category. If you aren‟t sure which category your 
function is in, selectALL. 

 

To make scrolling to your function quicker when you are in the ALL category: 

Click somewhere in the “SELECT A FUNCTION” area of the 

dialogbox;Type in the first two or three letters of the name very quickly. 

For example  
if you type VLO quickly, it will return VLOOKUP. If you type it slowly, you 
will get the functions starting with the letter “V”, and then when you type 
“L” the list will change to the functions beginning with the letter”L”. 

 
If you used the function recently, select the MOST RECENTLY USED category – 

this is a convenience list of your recently used functions. 
c) A brief description of the selected function. 
d) A link to take you to Excel‟s comprehensive help menu for further 

details on the selected function, this includes examples of use.  
3. Once you have found the function you require, select it then click on OK. 
4. The FUNCTION ARGUMENTS dialogbox appears. Most of the time you will 

be required to enter the arguments yourself.  
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The data in the text box can be changed by either:  
Clicking in the formula bar in the main excel window in and 

changingthedata;  
 Dragging over cells behind the FUNCTION ARGUMENTS dialogbox (the dialog 

box can be moved to make viewing easier – just click and drag on the title

bar); or 
Temporarily collapsing the FUNCTION ARGUMENTS dialog box by 

clickingon the COLLAPSE DIALOG icon. This will then allow you to select 
larger ranges without hindrance. When you have selected the range/data 
click on the restore button  

 
 
 
 
 
 
 
 

 

5. When you have finished filling in all the arguments required in your 

function, click on OK. 
 

Restoring the Function Arguments dialog box in order to edit a function 
1. Click in the cell where the functionis.  
2. Click on the INSERT FUNCTION icon (the fx button) to restore the dialogbox.  
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Shortcut for entering a function  
You can access your most recently used functions without having to go through 
the INSERT FUNCTION dialog box.  

1. Make sure you are in the cell where you want the function to be. 
Instead of clicking on the fx icon to start your function, type an equal 
sign (=). You will see the function that was last used in the space 
where the cell address normally shows.  

2. Either click on the function name (if it is the one you want to use), or 
click on the drop down arrow next to the function name to see the list 
of recently used functions. 

 

Click here if Click on the drop down  
you want to arrow to access the 
use the Most Recently Used 
function that list. 
is shown.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

The Most Recently 
Used List.  
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3. As soon as you click on the required function, you will go straight to 

the FUNCTION ARGUMENTS dialog box, bypassing the INSERT 

FUNCTION option. 
 

Some commonly used Functions  
 Char(Number): This function returns Character of any ASCII code. 

Example =char(97) will return “a”.

 Concatenate: (“Text1”, “Text2”): Will concatenate two strings.
 Len(String): Counts number of character in a string. This includes the 

white spaces also.

 Trim(String): Removes unwanted white spaces of a string.
 

Date and Time Function:  
 Days360(“StartDate”,”EndDate”): This function returns difference between 

the start date and the end date in integer value in a 360 day year. 
Example: =Days360(“12/12/2011”,”12/13/2011) will return 1.

 Date(year, Month, Day): This function returns a numeric equivalent of the 
date. Example, =DATE(2012,10,5) will return 05-10-2012

 Now(): This function returns the current System date and time.


 Today(): Returns System‟s Current Date.
 

Mathematical and Statistical Functions:  
 ABS(Number): This function returns the absolute value of the number 

supplied as the argument.

 Int(Number): This function returns rounds of the number, passed as the 
parameter to the near integer.

 Sqrt(Number) : This function returns the square root of the number 
passed as the parameter.

 Power(Number, Power): Multiplies a number with itself for the given 
number of power. Used to find out squares, cubes etc.

 Mod(number, Divisor(): Returns the remainder of the division of the 
number divided by the divisor.

 Max(Number1, Number2,....): Finds out the maximum out of the given 
numbers.

 Min(Number1, Number2,....): Finds out the minimum out of the given 
numbers.

 Average(Number1, Number2,....): Finds out the average out of the given 
numbers.

 Count(Value1, Value2...): Counts the number of values passed as the 
arguments. 
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Logical Functions:  
 AND(logical1, Logical2,...): Returns true if all the conditions satisfies and 

returns false if any single condition fails to comply.
Example, =AND(A3>10,B3>20) will return True only when both A3 >10 

and b3>20 or else will return False.

 OR(Logical1, Logical2,....): Returns true if any of the condition satisfies.
 

Example, =OR(A3>23,B3>10) will return true if either value at cell A3 > 

23 or B3 > 10 else it will return false. 
 NOT(Logical) : Will return True if the logic is false or else returns True.

 

Example, say value at cell A3 is 10 then “=NOT(A3>30)” will return True.  
 IF(condition, IFTrue, IFFalse): Returns one value if condition specified is 

true or the other value if the condition is false.
 

Example=(if(b4>35,”Pass”,”Fail”) will return Pass if value at cell b4 > 35 

and will return “Fail” if value less then equal to 35. 

CONCATENATION 
The CONCATENATE function joins strings of text together. It is often used when 
working with databases but is also useful for consolidating information. There 
are two methods of concatenating text, with the CONCATENATE function or by 
using the & operator. Both are explained here. 

 
Example : When doing consolidations where you have to combine information, 

you may end up with a list where items often mean the same thing e.g. imagine 

working with two different companies each with their own expense sheet. It is 

your job to bring the expenses together in a consolidated expense sheet. 
 

DodgyBrothers Sweet ToothCafe 
 

Wages Telephone 
 

Electricity  
 

Communications 
COGS 

 

Power 
 

Rent Lease 
 

COGS Salaries 
 

In a consolidated expense sheet this may look better presented as: 
Wages & Salaries 

Electricity & Power 
Rent & Lease 
Telephone & Communications 
COGS & COGS  
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COGS would look unusual being mentioned twice so we have combined it into 

one listing, using an IF function. 
 

The listing for the consolidated information could be typed as ordinary text, 

however you would be breaking a basic rule of spreadsheeting - Do not repeat 

information, use cell references. If you change the ORIGINAL text in any way 

whatsoever, the change will automatically be reflected in the Consolidation if you 

use Concatenation to combine the information.  
In the following detailed instructions there are two ways of handling 
concatenation, one where words are combined (Electricity and Power) and one 
where the listing is only mentioned once (COGS). An exercise has been set up for 
your convenience and can be found in the working example Consolidation. The 
first two worksheets belong one each to Dodgy Brothers and Sweet Tooth Café, 
the third worksheet is the consolidation where you can concatenate the cells. 

 
Example 1 - Combining two entries using the & operator 

Join the two cell references with &” and “& 

Wages and Salaries have been combined  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

In Excel you normally have operators such as +, -, / or * between cell 

references, which asks Excel to add, subtract, divide or multiply the contents of 

those cells. In this scenario however, we are joining two cells that contain text. 

The & symbol is the operator used for joining cells with text. They are usually 

in pairs so that in between the symbols you can indicate what text you want to 

join the words (a space or words, punctuation etc). This text must be enclosed 

in double quotation marks – “”  
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1. Using the Consolidation workbook as an example, make sure you are in 

Cell A5 on the CONSOLIDATION worksheet.  
2. Type an “=” sign (the beginning of everyformula). 
3. To get the first cell which contains the word “Wages”, click on the 

DODGY BROS worksheet tab at the bottom of the window, then click in 
A5, the cell address „Dodgy Bros‟!A5 should be in the address bar.  

4. Type an ampersand (a & symbol, found above the number 7 on the 
keyboard). This tells Excel you are going to add some text or point to 
another cell containing text.  

5. We want some text between the words “Wages” and “Salaries”. This text 
is a space, followed by the word “and” followed by another space. After 
the & you just typed, type “ and “ (a double quotation mark, a space, 
the word “and” and then another space, close the quotation marks). 
Any text you want between cells MUST BE ENCLOSED IN DOUBLE 
QUOTATION MARKS.  

6. Type another &. This tells Excel you are ready to point to another cell. 
The &”....................”& is the way to combine cells containing text with 
whatever text or symbols you place between these characters - in our 
case with a space, the word “and”and another space.  

7. Click on the SWEET TOOTH CAFÉ worksheet tab. Then click in cell A5 
(the cell containing the word”Salaries”.  

8. To finalize the formula, click on the Green–’ or hit ENTER on the keyboard. 

9. Repeat the above instructions to create the Electricity & Power, Rent & 
Lease and Telephone & Communications cells. (if you were sure they  
were entered in the same order on both worksheets, you could use the 
Fill Handle to copy the formula).  

Example 2 – By using an IF function, combine two entries, ending up with one 
entry  
In the case of the COGS entry, combining them as in the first example, we would 
end up with COGS and COGS which is exactly the same thing and would not look 
very professional. By using an IF function we can say make Excel show COGS only 
once, but if the original text changes then reflect that change automatically.  
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1. Ensure you are in Cell A9 of the CONSOLIDATION worksheet.  
2. Call up an IF FUNCTIONS ARGUMENTS window.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Logical_test 

 click on DODGY BROS worksheet and select A8.

 Type an “=”sign

 Click on SWEET TOOTH CAFÉ worksheet and select A8. 
i.e. you are asking “is the cell A8 in Dodgy Bros the same as cell A8 in Sweet Tooth 

Café”. The result of the logical test is “True”. The cells are the same as each other. 
1. value_if_true 

Click on DODGY BROS worksheet and selectA8. 
i.e. if the cells are the same, you only wish to have the word “COGS” appear once. 

2. value_if_false 

 Click on DODGY BROS worksheet and select A8

 Type the following &” and”&

 Click on SWEET TOOTH CAFÉ worksheet and select A8 
i.e. if the cells aren‟t the same, show the contents of the two cells joined by the 

text “ and “ 
3. Click on OK to finish the formula.  

To see if this works correctly, try going to the DODGY BROS worksheet and changing 

Cell A8 to read “Cost of Goods Sold ”. Go back to the CONSOLIDATION worksheet and 

see if the cell containing COGS now reads “Cost of Goods Sold and COGS” 
Example 3 – Using the CONCATENATE Function 
The text cells can be joined by using the CONCATENATE function, which is found 
under the TEXT category of functions.  
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1. Call up a CONCATENATE FUNCTION ARGUMENTS window  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

2. In Text1, click on DODGY BROS worksheet and select A8. Then click in 

Text2. Note Text 3 automatically appears (you can join upto 30 strings 

of text) 
3. In Text 2 type a space, then the word and, then type anotherspace. 
4. Click in Text3 – note how the quotation marks have been added 

automatically for you in the Text 2 dialogbox  
5. Click on SWEET TOOTH CAFÉ worksheet and select A8 
6. Click on OK to finalize the formula. 

 
To fix up the problem of COGS appearing twice, you would have to create 

an IF function and when you get to the “VALUE-IF_FALSE” section, call up a 

CONCATENATE function and fill in as per instructions above.  
The final step to completing the exercise is to bring across the figures for 
DODGY BROS and SWEET TOOTH CAFÉ. These will be normal formulas – do 
not retype the figures because if the original figures change, the retyped 
ones on the CONSOLIDATION worksheet will not change. By using the 
following instructions the consolidation figures will automatically update 
with any changes. 
Using Wages and Salaries as an example: 
1. Using the CONSOLIDATION worksheet, click in B5. Type an “=” sign 

to start off a formula. 
2. Click on the DODGY BROS worksheet tab and select B5 (the first wages 

amount).  
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3. Type a “+”sign  
4. Click on the SWEET TOOTH CAFÉ worksheet tab and select B5 (the 

first salaries amount) 
5. Either click on the green– or hit ENTER on the keyboard to finalize. 
6. Use the fill handle to drag this formula across to February and March 
7. When you have finished inputting all the consolidated figures, check 

the final totals agree with the final totals of the first two worksheets. 
 

WORKING WITH TEXT  
There are many functions under the TEXT category and once you have worked 
with a few the others are quite easy to follow. Some of the more common text 
functions are: 

 
  
 

 
 
LOWER  
MID 

 
 
  
 

 
 
PROPER  
RIGHT 

 
 
  
 

 
 
UPPER  
LEFT  

  A  B  C  
 

 1 Richards  julia    
 

 2 Thompson  sarah    
 

 3 Smith  fred    
 

      
 

 Syntax  Description Example  
 

      

 =lower(cell address) Gives you the text all in lower case =lower(A1) would return  
 

     "richards"  
 

     
 

 =upper(cell address) Returns text string in upper case =upper(A1) would return  
 

     "RICHARDS"  
 

     
 

 =left(cell address) Returns the leftmost character in a text =left(A1) would return "R"  
 

   string    
 

     
 

 =right(cell address) Returns the rightmost character =right(A1) would return "s"  
 

   in a text string    
 

     
 

 =mid(cell_address,whe Returns characters from a specified Example - to return the 1
st  

 

 re_to_start,how_many_ point in the text three letters of the  
 

 characters_ to_return) 
Has 3 arguments. surname  

 

      
 

   
1.  Cell address =mid(A1,1,3) would return  

 

   

"Ric"  
 

      
 

   2.  Which character to start    
 

   from (first character is no 1)    
 

   3.  How many characters do    
 

   you want to appear    
 

       

 =proper  Makes the first letter of character =proper(B1) would return "Julia"  
 

   string uppercase    
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Nested Text Functions  
If nesting text functions (having more than one function in the same formula) 
ensure you enter the formulas in the right order.  
For example: If you wanted the first 3 letters of the surname 
in Lower case:  
Rightway: = lower(mid(A1,1,3)) would return”ric” 
Wrongway:=mid(lower(A1,1,3)) would return an error 

 

WORKING WITH DATES  
Dates are stored as numbers in spreadsheets and because of this you can do 

calculations using dates. Take the number 36500.35 for example. The integer 

component (36500) is the date and the decimal fraction (.35) is the time. The 

integer number is the number of days since 01/01/1900. The number 36500.35 

therefore, would be 6 December 1999, 8.24am.  
By going to the TOOLS, OPTIONS menu and clicking on the CALCULATION tab 

you can enable the 1904 DATE SYSTEM option which calculates all dates from 

January 1, 1904.  
When you enter a date into a cell in a worksheet Excel formats that cell as a date 

format. If you then try and put a normal number into that cell, it will appear as a 

date. This is because the formatting information and the data are stored 

separately in spreadsheets. To correct the situation you need to reformat the cell 

as a number (FORMAT, CELLS, NUMBER) or clear the format (EDIT, CLEAR, 

FORMATS). You can also use the shortcut key to return a cell to GENERAL format 

– CTRL + SHIFT + ~ (a tilde).  
NOTES : If you are typing a date into a cell, you can use either / or –(slashes or 

hyphens) as separators. E.g. 31/12/99 or 31-12-99 do the same formatting.  
If entering a date with the year between 1920 and 2029, you only need to enter 

the last two digits. Before or after these years, enter the four numbers for the 

date to appear correctly.  
The easiest way to enter a quantity of dates in a row or column is to use the 

EDIT, FILL, SERIES command. You can then make the dates appear in Day, 

Weekday, Month or Year series. Alternatively you can use the fill handle with the 

Right Mouse Button to select a series of dates. 

CTRL + ; is a shortcut for entering the current date. 
A cell with a date can be reformatted to appear the way you want by going to 

FORMAT, CELLS, DATE (for pre-designed formats) or FORMAT, CELLS, CUSTOM to 

design your own format. The following table shows some of the different ways of 

formatting a date – using 6 August 2004 as an example:  
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m/d 8/6 
   

d/m 6/8 
   

d/m/yy 11/8/04 
   

dd/mm/yy 06/08/04 
   

d-mmm 6 Aug 
   

d-mmmm 6 August 
   

dddd d mmmm yyyy Friday 6 August 2004 
   

 

Useful Date Functions 
There are many DATE functions available but some common ones are: 

 
DATE Returns a serial number that represents a particular date. The result is 

formatted to appear as a date. This function is most often used when creating a 

date from values in a spreadsheet. Calculations can be performed on these dates 

because they are stored as a serial number 
 

Syntax: = DATE (year, month, day)  
 
 
 
 
 
 
 
 
 
 
 
 
 
 

NOTE: If you enter an invalid month e.g. 14, Excel assumes you wish to use 

Febru-ary (12 months + extra 2 months into the new year). If you enter an 

invalid day such as 45, Excel will add that number to the first day of the month. 
 

Example: DATE(2004,14,45) would return 17 March 2005. (1st February 2004 + 

45 days)  
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Example: 

 

DAY : Returns a number as a value corresponding to the day in a date–

numbersrange between 1 and 31. 
Useful if you need to extract the day so as to perform calculations. 
Syntax:DAY(serial_number)  
Example: Two examples are given, the first where the formula refers to a cell 
containing a date, the other where the date is used in the formula itself – Note 
that the date is enclosed in quotation marks. If the quotation marks were not 
there Excel would attempt to take 17 and divide by 12, then the result would be 
divided by 1979.  

 
 
 
 
 
 
 
 
 
 

MONTH : Returns a number as a value corresponding to the month in a date– 

numbers range between 1 and 12. 

Useful if you need to extract the month so as to perform calculations. 
 

Syntax: MONTH(serial_number) 

 

Example: Two examples are given, the first where the formula refers to a cell 

containing a date, the other where the date is used in the formula itself – Note 

that the date is enclosed in double quotation marks. If the quotation marks were 

not there Excel would attempt to take 17 and divide by 12, then the result would 

be divided by 1979.  
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YEAR : Returns a number as a value corresponding to the year in a date–numbers 

range between 1900 and 9999. 
Useful if you need to extract the year so as to perform calculations. 

 

Syntax:YEAR(serial_number) 
 

Example: Two examples are given, the first where the formula refers to a cell 

containing a date, the other where the date is used in the formula itself – Note 

that the date is enclosed in double quotation marks. If the quotation marks were 

not there Excel would attempt to take 17 and divide by 12, then the result would 

be divided by 1979.  
 
 
 
 
 
 
 
 
 

 

TODAY : Returns the current date. Useful for inserting into a spreadsheet where 

the current date is required. This function does not require any arguments. The 

date updates everytime a calculation is made in the worksheet. 
 

Syntax:=TODAY() 
 

Example:  
 
 
 
 
 
 
 
 
 
 
 

 

NOW : Returns the current date and time. This function does not require any 

arguments. The date and time update everytime a change is made in the worksheet. 
 

Syntax:=NOW()  
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Example:  
 
 
 
 
 
 
 
 
 
 
 

ROUNDING FUNCTIONS  
Numbers can be rounded to decimal places by using the INCREASE or DECREASE 
DECIMAL on the Formatting toolbar or the FORMAT, CELLS, NUMBER option, 
however you are not changing the value of the number when you use these, only 
the display. For example, if you have 123.654 decreased to 123.65, you will see 
123.65 in the worksheet but 123.654 in the address bar. Excel will use the 
underlying value (123.654) to do any calculations, not the displayed value.  

 
 
 
 
 
 
 
 
 
 
 
 
 

ROUND : Rounds a number to a specific number of decimal places. It is made up 

of 2 arguments, the reference to a number and the number of decimal places 

that reference is to be rounded to. 
 

Syntax: = ROUND (number, num_digits) 
 

Notes: The number argument can be a number, a cell address referring to a cell 

that holds a number, or a formula which results in a number.  
The num_digits argument can be a negative or positive integer (whole number). If you 

use a negative number it rounds that number of places to the left of the decimal 

point. If you use 0 (zero), it number rounds to the nearest whole number.  
Numbers less than 5 get rounded down. Numbers that are 5 or more get 
rounded up.  
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Examples:  
 
 
 
 
 
 
 
 
 
 
 
 
 

Assuming that Cell A1 holds the number 2365.854, using the ROUND formula in 

the following ways will return: 
=ROUND(A1,0) 2366 
=ROUND(A1,1) 2365.9 
=ROUND(A1,2) 2365.85 
=ROUND(A1,3) 2365.854 

=ROUND(A1,-2) 2400 
A number can be used as the Number argument e,g:=ROUND (2365.854,-3) 
would return 2000 

 
ROUNDDOWN Works in the same way as ROUND, however as its name suggests, 

this function roundsdown. 
 

Syntax: = ROUNDDOWN (number, num_digits) 
 

Examples: Assuming that Cell A1 holds the number 2365.854, using the 
ROUNDDOWN formula in the following ways will return: 
=ROUNDDOWN(A1,0) 2365 
=ROUNDDOWN(A1,1) 2365.8 
=ROUNDDOWN(A1,2) 2365.85 
=ROUNDDOWN(A1,3) 2365.854 

=ROUNDDOWN(A1,-2) 2300 
ROUNDUP Works in the same way as ROUND, however as its name suggests, this 
function roundsup. 

 

Syntax: =ROUNDUP(number,num_digits) 
 

Examples: Assuming that Cell A1 holds the number 2365.854, using the 

ROUNDUP formula in the following ways will return:  
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=ROUNDUP(A1,0) 2366 
=ROUNDUP(A1,1) 2365.9 
=ROUNDUP(A1,2) 2365.86 
=ROUNDUP(A1,3) 2365.854 

=ROUNDUP(A1,-2) 2400 
 

EVEN Using this function a number can be rounded up to the 

nearestevenintegeror down to the nearest even negative integer. 
Syntax:Examples: = EVEN(number) = EVEN(13.6) 14 

 = EVEN(16.2) 18 

 = EVEN(16) 16 

 = EVEN(-3) -4 
ODD This function rounds a number up to the nearest odd integer or down to the 

nearest odd negative integer. 

Syntax: =ODD(number)  
Examples: =ODD(13.6) 15  

=ODD(16.2) 17  
=ODD(17) 17  
=ODD(-4) -5  

CEILING The CEILING function rounds a number up to the nearest specified 

multiple. This is a useful function for rounding someone‟s wages to the nearest 5 

cents for example, since 1 and 2 cent pieces have been discontinued. 
 

Syntax: = CEILING (number, multiple) 

Examples: = CEILING (2365.81,.05)=CEILING(2365.81,-.05) 2365.85#NUM! 

= CEILING(-2365.81,-.05) -2365.85 
Note: The number argument and the multiple argument must have the same sign 

or the function will return a #NUM! error. 
 

FLOOR The FLOOR function rounds a number down to the nearest specified multiple. 
 

Syntax: =FLOOR(number,multiple) 
 

Examples: =FLOOR(2365.81,.05)=FLOOR(2365.81,-.05) 2365.80#NUM! 

=FLOOR(-2365.81,-.05) -2365.80  
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Note: The number argument and the multiple arguments must have the same 

sign or the function will return a #NUM!error. 
 

INT The INT function rounds numbers down to the nearest integer. 
 

Syntax:=INT(number) 
 
 

Example: =INT(2365.80) 2365 
 

TRUNC The TRUNC functions truncates numbers to the right of the decimal point. 
 

Syntax: TRUNC (number, num_digits) num_digits isoptional 
 

Example: =TRUNC(2365.8045) 2365 

=TRUNC(2365.8045,2) 2365.80 

=TRUNC(2365.8045,1) 2365.8 
 

LOGICAL FUNCTIONS  
The AND, OR and NOT functions, like the IF function, are found under the 
LOGICAL category of functions available in Excel.  
Although they can be used in their own right, these functions are most often found 

being used to increase the logical comparisons you can make within an IF function. 
 

The AND and OR Functions  
Both of these functions can have up to 30 arguments. The difference between 
them is that:  
 with an AND function, all arguments MUST be TRUE, to return a TRUE 

result. Only one comparison needs to be false to make the result FALSE.

 With an OR function, only one of the comparisons needs to be TRUE to 
return an answer ofTRUE.

 
Example1 (Using the AND function) - Using a Sales Commission example, an 

employee gets a 10% bonus commission when his sales meets a target ($1,500) 

AND he has worked for the company for 2 or more years (2 comparisons). If 

these comparisons are true he gets the 10% bonus, if he doesn‟t meet these 

conditions he gets a 5% bonus as long as he has sales of $500 or more (another 

IF function). If sales are less than $500, the commission is zero.  
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If we do an OR function using the same example, we would get a 

different result, What we would be saying is an employee gets a 

10% bonus if he reaches the $1500 target OR he has worked for 

the company for 2 or more years. Therefore in this case he would 

get his 10% bonus commission if he only has sales of $1,000. 
 

Syntax: =AND(logical1,logical2,……….logical30) 
=OR(logical1,logical2,……….logical30) 

 
logical# the comparisons you make, (each to be separated with a 

comma) upto 30 are allowed as long as it does not exceed 

1,024 characters in total. 
 

Creating the AND function within an IF statement  
1. Ensure your cursor is in Cell D8. Bring up the IF FUNCTION ARGUMENT 

dialog box. 
2. In a normal IF Function we would be using only one conditional test here. 

However we have two tests to make so we use the AND function. You have 

a choice of either manually typing the AND function in the Logical_test 

dialog box, or using the AND FUNCTION ARGUMENTS dialog box. If using 

the latter, make sure the cursor is in the Logical_test dialog box then click 

on the drop down arrow on the Name Box (which should have the word “IF” 

on it), and select the AND function from the list (go into MORE FUNCTIONS 

if AND is not in the list).  
 
 
 

 

Step 1 - Make sure 

your cursor is in the 

Logical_test dialog box  
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Step 2 – Click on 

the drop down 

arrow here  
 
 
 
 
 
 
 
 
 

Step 3 – Select the AND 

function from the list or go 

into “More Functions” if AND 

is not in the list. 
 
 
 
 
 
 
 
 
 

 

3. The AND FUNCTION ARGUMENTS window appears. Your cursor should be 

in the Logical1 dialog box. Click in B8 (the first sales figure), type in “>=” 

and then click in B5 (the sales target figure). After clicking in B5, press 

the F4 key to make B5 absolute. (If you don‟t, when you copy the formula 

down to other rows, B5 will change to B6, then B7 and so on. This 

reference must always be talking about the figure in B5). Logical1 should 

now read B8>=$B$5 
 

4. Click in the Logical2 dialog box (notice that Logical3 automatically gets 

added). The second comparison is now entered. Click in C8 (the amount 

of years the staff member has worked for the company), type” > =”, 

finally type the number 2.  
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5. Click on OK. Excel now believes you have finished the formula and 

returns you to the worksheet. However there is an error (because the 

formula has not been finished), the following message will appear.  
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Click on OK to get rid of the message. To bring the FUNCTION ARGUMENTS 

dialog window back up, click in the formula bar where the IF function part of the 

formula is, and then click on the fx button.  
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Step 1 – Click on the fx button 

Step 2 – Click in the “IF” part of the formula  
6. The IF FUNCTION ARGUMENTS window will reappear, with the AND function 

information in the Logical_test dialog box.  
NOTE: If you want to manually type in the AND Function, replace Step 2 by typing in 

the function name, open the brackets and put in the arguments, each separated by a 

comma. End by closing the brackets. (Don‟t forget to make the reference to B5 

absolute. Go to Step 8 when you have done this. Your value_if_true should read :  
AND(B8>=$B$5,C8>=2) 
7. In the value_if_true dialog box, type in the TRUE result – i.e. click in B8 to 
select the sales amount then type “*10%”. value_if_true should then read B8*10%  
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8. The value_if_false is another IF function – to find out IF the salesperson 

has earned $500 or more. Making sure your cursor is in the value_if_false 

box, go and request another IF Function. Use the instructions in Step 2 

which show you where to click to request anotherfunction.  
9. Fillinthedetailsasshown below (note that value_if_true is 0 – they get no 

commission if sales are less than $500).  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

10. Click on OK to finish the function. If filling several cells with this formula, 

use the FILL HANDLE to drag down to the other cells. 
If you were to manually enter the above formula it would look like: 

IF(AND(B8>=$B$5,C8>=2),B8*10%,IF(B8<500,0,B8*5%)) 
 

Creating the OR function within an IF statement  
Repeat all of the above instructions but using the OR function rather than the 
AND function. Note that the results are different. This is because anyone 
achieving either of the comparison tests (earning over $1500 OR having worked 
for 2 or more years), will earn them a 10% bonus. 

 

The NOT function  
The NOT function only has one argument. Again it can be used on its own, but is 
usually used in conjunction with an IF function. Whereas most of our logical 
functions return TRUE if the argument is true, and FALSE if the argument is false, 
the NOT function returns FALSE if the argument is true, and returns TRUE if the 
argument is false. 

Syntax: =NOT(logical) 
 

Example: Using the Pass/Fail of students example, a letter must be sent 

to the students who failed. To aid in flagging these, a formula 

is created to put the word “Send” next to those who have failed.   
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Create an IF Function and fill in the following details by going and calling in a 

NOT FUNCTION ARGUMENTS window. Remember that any text you request must 

be enclosed in quotation marks.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. Click on OK to finish the function. If filling several cells with this 

formula, use the FILL HANDLE to drag down to the other cells. 
 

If you were to manually enter the above formula it would look 

like:=IF(NOT(D21=”Pass”),”Send”,””) 

IF FUNCTION 
The IF function is located in the LOGICAL category of functions in Excel. Its job is 
to do a conditional test on criteria that return different answers depending on 
whether the results of the test are true or false. 

 

The conditional test can be made on values, text or on formulas  
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Example1: A typical example is that of a lecturer giving a PASS to a student 

having a score of 10 or more in an exam, and a FAIL if they 

have a score less than 10. The logical test is to find out what 

their score is, then return a PASS or FAIL depending on the 

outcome of the test.  
Example2: Staff in a hardware store receives 5% commission if they achieve 

budget. The logical test is to find out whether they have 
achieved budget and then give them 5% commission if they 
have, no commission if they haven‟t.  

Syntax: If (Logical test, value if true, value if false) logical test is the test 
performed on a value or expression. The result of the test must 
be able to be evaluated to TRUE or FALSE. The logical test uses 
comparison calculation operators e.g: 

= equalto 
> greater than 
<less than 
>= greater than or equal to 
<= less than or equal to 
<> not equal to  

Julia Richards has a score of 15 in her exam, the logical test would be to find out 
if C6 is greater than or equal to 10 (shown as C6>=10). In this case, the answer 
would be TRUE, cell C6 is greater than 10. Julia Richards will get a PASS.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The logical test would be to find out if the cells in column B are greater than the 

sales target found in cell B21. The logical test is to find out if B25 is greater than 

or equal to the amount found in cell B21 (B25>=$B$21). It isn‟t greater so the 

an-swer would be FALSE. (Note how B21 has been made absolute so that when 

the formula is copied down, each line will refer to the amount in B21 . The first 

staff member has not reached or equaled the sales target and therefore will not 

get the 5% commission.  
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value_if_true is one of the values that can be returned from the logical test. 
 

If you want the answer to be “True”, then the text “TRUE” would be used (can be 

lower or upper case). Any text can be used, just make sure it is enclosed in 

quotation marks (“text to be returned”).  
If you want the answer to be nothing, leave the argument blank or type “”. (In 
Excel text expressions are enclosed within quotation marks).  
You can use another formula if the answer is true i.e. sum figures or multiply by 
an amount. 

 
value_if_false is the other value that can be returned from the logical test. The 

same arguments as for value_if_true are used except if you want “False” to be 

returned, type the text”FALSE”. 
 

Creating the IF Function – Example 1  
Use the IF function to work out whether students have a Pass or Fail (P or F). 
1. Place your cursor in the cell where the result will be 
IF FUNCTION ARGUMENTS dialog box showing on your Excel worksheet.  

 
 
 
 
 
 

Message showing 

current result of 

your logical test  
 
 
 
 
 
 
 
 



 

 

 
 
 
 
 
 

 
MS Excel 2007 71  

 
 
 
 

Results that will be used 

after the logical test has 

been completed. 
 
 
 
 
 
 

 

3. The Logical_test is where you put your argument – which must return 

an answer of true or false. In the above figure we refer to Julia 

Richards‟ exam result in C6 and ask if it is greater than or equal to 10. 

Note the “TRUE”message.  
4. value_if_true – Type the word “Pass” (If using the Function Wizard the 

quotation marks are automatically typed in for you). Note the result at 
the right- hand side of the dialog window. This is the result you will 
get if the argument is TRUE.  

5. value_if_false – Type the word “Fail”. This is the result you will get if the 
argument is FALSE.  

6. Click on OK to finish the function. If filling several cells with this 
formula, use the FILL HANDLE to drag down to the other cells.  

The arguments are not always text, it can be another formula or a value, or if a null 

(no result) is required, nothing (or “”. i.e. nothing between the quotation marks). 
 

Creating the IF Function – Example 2 
The second example – using sales commission, requires a formula to be used.  
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In this case the Logical_test is asking if the value in B25 (on the IF FUNCTIONS 

worksheet) is greater than or equal to B21 (the target the sales people have to 

achieve in order to get any commission, note that this reference is Absolute). 
The value_if_true is saying if the target is achieved; multiply the amount by 5%. The 
value_if_false is saying if the target is not achieved, give 0 commission. 
Manually Creating an IF Function 
Once you are confident with IF functions you may decide to type the formula rather 
than use the FUNCTION ARGUMENT dialog box. Just remember: 
 To use = IF as the function
 In side the parenthesis (brackets) you have 3 argument swhich MUST be 

separated by commas(,)

 If your equire a result to be text, the text must been closed inside quotation 

marks e.g. “Pass” or “Fail” or “” (the latter is to have no text appear)).

=IF(B25>=B21,B25*5%,0) 
or
=IF(B25>=B21,B25*5%,””) 

NESTED IF FUNCTION 
Occasionally a single IF statement may not be enough to give you the results you are 
looking for. The traditional example of this is taking the student example. In the 
figure below, Column D is the normal IF function which finds out whether the student 
has passed or failed. Column E, however, is asking what grade the student is to 
receive based on the followingtable:  
The normal IF Function will not give you the required result. You need more than one IF 

function to complete the job – you can do this with a NESTED IF FUNCTION i.e. more than 

one IF Function, one inside the other (you are allowed up to 7 nested functions).  
 

A = 17-20 
B = 14-16 
C = 11-13 
D = 8-10 
E = 7 or below 

 
 
 
 

 

Put in simple terms, our nested IF statement is going to be: 
First IF statement: 
Logical test – see if C6 has a value of 7 or below (C6<=7) 
If true- Give an “E”grade  
If false- see IF C6 has a value of 10 or below to work out whether this student 
should have a “D” grade – this will lead to the second IFstatement  
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Second IF statement: 

Logical test - see if C6 has a value of 10 or below (C6<=10) 

If true- Give a “D”grade  
If false- see IF C6 has a value of 13 or below to work out whether they should get 

a ”C” grade – this leads to the third IF statement 
 

Third IF statement: 

Logical test - see if C6 has a value 

of 13 or below (C6<=13) 

If true- Give a “C”grade 

If false- see IF C6 is a value of 16 or below to work out whether they 

should geta ”B” grade – this leads to the fourth (and last) 

IFstatement 
 

Fourth IF statement: 

Logical test - see if C6 is a value of 16 

or below (C6<=16) 

Iftrue- Give a “B”grade 

If false - it must be true that C6 is between 17 and 20 as there are  
no other possible marks left. Therefore “A” should be 

entered here to indicate the top grade possible. 

 

Each statement above has a logical test, then a value_if_true, then a 

value_if_false. The step by step instructions, using the FUNCTION ARGUMENT 

dialog box and the scenario about a student‟s grades as an example are:  
1. Ensure your cursor is in Cell E6. Call up the IF FUNCTION ARGUMENT 

dialog box.  

2. Put in the first logical test (point and click on Cell C6 then type <=7) 

and the Value_if_true result (the student would get an “E” if true).  
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1. Fill in the 

first two 

dialogueboxes 
 
 
 
 

2. Then click 
inthe 
“Value_if_false” 
dialoguebox 

 
 
 
 

 

3. Make sure your cursor is in the “Value_if_false dialog box. Now click on 

the IF function in the name box to bring up a brand new FUNCTION 

ARGUMENTS dialog box.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Click on the IF function to 
create a new FUNCTIONS 
ARGUMENT dialog box 

 

4. In the new FUNCTION ARGUMENTS dialog box, type in the next 

argument, and the Value_if_true result (see if the student has a mark 

of 10 or less, and if so give them a”D”).  
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5. Repeat Step 3  
6. Repeat Step 4 but this time the logical test is to see if the student 

has a mark of 13 or less. If it is TRUE, they will get a”C”  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Repeat Step 3 to bring up a final FUNCTION ARGUMENTS dialog box. This is the 

only tricky part, knowing when to stop asking for more new arguments. Here the 

final logical test is entered (C6<=16). Notice that the result of this argument is 

TRUE. The value_if_true is a mark of B. The value_if_false must therefore be 

some-one who has more than 16 marks and gets an”A”.  
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This argument is 

TRUE 
 
 
 
 
 
 
 
 
 
 
 
 

 
7. Click on OK to finish the function. If filling several cells with this formula, use 

the FILL HANDLE to drag down to the other cells. 
 

If you were to manually type the above formula it would look like:  
=IF(C6<=7,”E”,IF(C6<=10,”D”,IF(C6<=13,”C”,IF(C6<=16,”B”,”A”)))) 

 
As you can see it looks a little complex, just remember that you must have the right amount 
of parenthesis in the right order, and commas separating the arguments. Usually this sort of 
formula is easier to create using the FUNCTION ARGUMENTS dialog boxes.  
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EVALUATING AND CHECKING ERRORS 
 

The Evaluate Formula dialog box in Excel walks you through the steps used in 

calculating a result from a formula. This helps locate errors in formulas that are 

long, or have precedents. For example, the formula = IF (MAX (Orders!B2:B29) > 

200, MAX (Orders!B2:B29)* Shipping!C22,Shipping!C24) refers to different 

worksheets. Using the Evaluate Formula dialog box makes it easy to see how this 

formula is worked out by Excel. The step-by-step approach lets you see what is 

done at each step. 
 

EVALUATING FORMULAS  
Follow these steps to evaluate a formula using the Evaluate Formula dialog box: 
Select the cell containing the formula and click the Evaluate Formula button on 
the Formulas tab of the Ribbon.The Evaluate Formula dialog box appears.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

USING THE EVALUATE FORMULA DIALOG BOX TO ASSESS A FORMULA  
Click the Evaluate button one or more times to evaluate each expression in the 
formula.With each successive click on the Evaluate button, the Evaluation box 
displays the interim results. The Step In and Step Out buttons are enabled during 
the steps that work on the precedents. 

 

CHECKING ERRORS  
A similar error-hunting tool is the Error Checking dialog box. To use this tool, 
follow these steps:  
Select the cell containing the formula and click the Error Checking button on the 
Formulas tab.The Error Checking dialog box appears.  
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CHECKING THE CAUSE OF AN ERROR  
Click any of the following buttons to help analyze the error and make decisions 
about how to correct it: 

 Help on This Error starts the Excel Help system.
 Show Calculation Steps opens the Evaluate Formula dialog box.
 Ignore Error ensures that Excel no longer cares about the error. 

The cell may still display an error symbol, but Excel doesn‟t give a 
hoot, and probably you won‟t either, since you clicked the button.

 Edit in the Formula Bar places the cursor in the Formula Bar, 
making it easy for you to edit the formula.

 Options open the Excel Options dialog box.
 Previous and Next cycle through the multiple errors on the 

worksheet, assuming there is more than one error. 
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SORTING AND FILTERING 
 

Excel‟s sorting and filtering functions range from very simple sorts to being able 

to filter out unwanted data in large lists of information. Lists typed into an Excel 

worksheet are often used as a data source for creating merge documents in 

Word, or for exporting to other databases such as Microsoft Access.  
If you are creating a list that is intended for using with a merge document, the 
information you type is organized into fields (columns) and records (rows). The 
fields (the headings of each column known as the header row), must be one 
word i.e. “Firstname” or “First_Name” is more correct than “First Name”. 
A list, unlike normal worksheet data, must not have entire blank rows or columns. 
However if information from a record is missing, a cell can be left blank.  
Once a list is created, it becomes easy to sort and filter the information. It can 
also be used to create pivot tables  
The Excel worksheet, Sorting and Filtering, has been set up to make practicing 
the following sorting and filtering methods more convenient.   
Simple Sorts  
Select any cell in the column that needs sorting, then use 
the SORT ASCENDING or SORT DESCENDING icons on the 
formatting toolbar.  
Do not highlight the column to be sorted. If you do, only that column will 
sort, the rest of the data will remain static. 

 

Sorting on more than one criteria (DATA, SORT)  
The DATA, SORT option is used if you wish to sort on more than one criteria. 
For example, you may wish to have a sort done on surname, then if there is 
more than one surname the same, sort on the first name, then the city the 
person comes from. You can have up to three selections using the DATA, 
SORT option.  

1. Select any cell within the list – this will help Excel to select the correct 
range of cells to be sorted. 

2. Click on DATA, SORT. The SORT 
dialog box will open.  

3. If your list has a header row, make sure this option is selected. Doing 
this makes the field names appear in the field names drop down text 
boxes.  

4. Select which field names are to be sorted, specifying each time 
whether the sort is to be in ascending or descending order. 

5. Click on OK  
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Filtering Data  
Filtered lists allow you to view only the specified data. This data can then be 
copied, printed etc. 
Example1: From your list you require a list of all males living in NSW 

1. Click on DATA, FILTER,AUTOFILTER  
2. Drop down arrows appear next to each heading in thelist.  

i. Click on the drop down arrow next to “GENDER” and select” Male” 

ii. Click on the drop down arrow next to “STATE” and select” NSW” 
 

Notice that the drop down arrow on both of these fields have turned blue. 
This is to show that these particular fields have had filtersapplied. 

To return each of the columns information back to normal, click on 
thedropdown arrow and select”ALL”  

If you have many columns to restore, it is quicker to click on DATA, FILTER, 
SHOW ALL 

 

 

Example2: You need a report listing everybody who lives in VIC or NSW, 

and was born before 1 January 1985. 
1. Click on DATA, FILTER,AUTOFILTER 
2. Select the drop down arrow next to “STATE” and select CUSTOM 
3. Fill in the CUSTOM AUTOFILTER dialog box the same as the 

following screenshot (make sure you select the OR option, this 
makes sure you are left with everyone who lives in NSW or VIC)  
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4. Click on OK  
5. Select the drop down arrow next to “DOB” and select CUSTOM 
6. Fill in the CUSTOM AUTO FILTER dialogbox  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Turning AUTOFILTER off 
 

When you have finished filtering your data, click on DATA, FILTER, AUTOFILTER 

(there should be a tick next to AUTOFILTER, clicking on this „unticks‟ the option).  
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GROUPING CELLS USING THE SUBTOTAL COMMAND 
 
 

Grouping is a useful Excel feature that gives you control over how the 

information is displayed. You must sort before you can group. In this section, we 

will learn how to create groups using the Subtotal command. 
 

To create groups with subtotals: 
 Select any cell with information in it.
 Click the Subtotal command on the Data tab. The information in your 

spreadsheet is automatically selected, and the Subtotal dialog box appears. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 Decide how you want things grouped. In this example, we will organize 

by Category.

 Select a function. In this example, we will leave the SUM function selected.
 Select the column where you want the Subtotal to appear. In this 

example, Total Cost is selected by default.

 Click OK. The selected cells are organized into groups with subtotals. 
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To collapse or display the group: 
 Click the black minus sign, which is the hide detail icon, 

to collapse the group.

 Click the black plus sign, which is the show detail icon, to 
expand the group.

 Use the Show Details and Hide Details commands in the Outline 
group to collapse and display the group as well. 

 
 
 
 
 
 
 
 
 
 

 

To ungroup select cells: 
 Select the cells you want to remove from the group.
 Click the Ungroup command.
 Select Ungroup from the list. A dialog box will appear.
 Click OK.

 

To ungroup the entire worksheet: 
 Select all cells with grouping.
 Click Clear Outline from the menu. 
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PIVOT TABLE 
 

Use a Pivot Table report to summarize, analyze, explore, and present summary 

data. Use a Pivot Chart report to visualize this summary data in a Pivot Table 

report, and to easily see comparisons, patterns, and trends. Both a Pivot Table 

report and a Pivot Chart report enable you to make informed decisions about 

critical data in your enterprise. The following sections provide an overview of 

Pivot Table reports and Pivot Chart reports  
Pivot tables are one of Excel‟s most powerful features. A pivot table allows you to 
extract the significance from a large, detailed data set. 

 
Our data set consists of 213 records and 6 fields. Order ID, Product, Category, 

Amount, Date and Country.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Insert a Pivot Table 
To insert a pivot table, execute the following steps. 
1. Click any single cell inside the data set. 
2. On the Insert tab, in the Tables group, click Pivot Table.  

 
 
 
 
 
 
 
 
 

The following dialog box appears. Excel automatically selects the data for you. 

The default location for a new pivot table is New Worksheet.  
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1. Click OK.  

Drag fields  
The PivotTable Fields pane appears. To get the total amount exported of 
each product, drag the following fields to the different areas. 

1. Product field to the Rows area. 
2. Amount field to the Values area. 
3. Country field to the Filters area.  

 
 
 
 
 
 
 
 
 
 
 
 

 

Below you can find the pivot table. Bananas are our main export product. That‟s 

how easy pivot tables can be!  
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Two-dimensional Pivot Table  
If you drag a field to the Rows area and Columns area, you can create a two-
dimensional pivot table. First, insert a pivot table. Next, to get the total amount 
exported to each country, of each product, drag the following fields to the 
different areas. 

1. Country field to the Rows area. 
2. Product field to the Columns area. 
3. Amount field to the Values area. 
4. Category field to the Filters area.  
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Below you can find the two-dimensional pivot table  
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To easily compare these numbers, create a pivot chart and apply a filter.  
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MACROS 
 

Introduction  
A macro is a recording of actions to automate tasks that are tedious or you do 
frequently. Some examples: 
 A macro to open a document you use everyday;

 A macro to add the months of the year across a row, centering and bolding 

the names of the month;

 A macro to select a group of cells;

 A macro to find out which cells have Conditional Formatting;

 A macro to setup a worksheet in a certain way and then print the 

worksheet. Excel provides some useful tools to help beginners to use macros and 

to start achieving results straight away without having to learn much about 

Visual Basic for Applications.

The following notes show how to:

 record a simple macro

 toggle between absolute and relative references when recording

 place a macro (assign a macro) on a tool bar icon

 assign a macro to a button on a worksheet so it is only available to 

that worksheet

 delete macros

Recording a macro 
These are instructions for recording a simple macro – selecting a range of cells 
you need to enter data into on a regular basis.  
Select TOOLS, MACRO, RECORD NEW MACRO. The RECORD MACRO dialogbox 
will appear.  
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2. In the MACRO NAME text box, type a name for your macro. Macro 

names cannot include spaces – an underscore is a good way to 

separate words. Do not use a cell address in the name as this will cause 

an error. Also, you may not use names of commands that already 

exist,e.g.Close. We have used Select Cells for our example.  
3. You may wish to give the macro a keyboard shortcut (which is typed in 

the SHORTCUT KEY text box). You can have a lower case or upper case 
letter. If you use a shortcut that is already assigned to another function 
(i.e. CTRL + B has already been assigned to BOLD), you will overwrite 
that shortcut whilst the workbook that is storing the macro is open. 

 

4. Decide where to store the macro This information gets entered in the 

STORE MACRO IN textbox:  
 Personal Macro Workbook – a workbook that is usually hidden from 

view, a macro stored here will be available everytime you use Excel, 
no matter which workbook or worksheet.

 This Workbook – the current workbook. Useful if the macro you are 

going to record is only to be available when you are using this 

workbook.

 New Workbook – Will open a new workbook where you can store the 
macro. You might do this because you want to have a similar macro 
workbook like the Personal Macro workbook – although unlike the 
Personal Macro workbook, this one will not open automatically. If 
you want to use the macros stored in this new workbook, you would 
have to physically open it first.



5. If desired, fill in a brief description in the DESCRIPTION text box – this 

is for your information only.  
6. Click on OK to start the recording process. You will be placed back in 

the main worksheet. A STOP RECORDING toolbar should appear (if not, 
click on VIEW, TOOLBARS, STOP RECORDING). This toolbar has two 
icons. An icon to stop the recording and one to toggle between 
recording relative or absolute addresses  

 
 
 
 
 
 
 
 
 
 
 



 

 

 
 
 
 
 
 

 
MS Excel 2007 91 

 
The Macro Recorder is active at this stage. The Macro Recorder records 

all keystrokes and commands that you use, so now is the time to be 

careful as any mistakes you may make will also be recorded. 
7. Enter data as normal. For our example, select a range of cells e.g.F1:G12.  
8. Click on the STOP button to stop recording or alternatively, click on 

TOOLS, MACRO, STOP RECORDING. 
 

Running a Macro  
The computer terminology for playing a macro is “Run”. To run a macro you 
can use any one of the methods following:  
1. Click on TOOLS, MACRO, MACROS (or use the keyboard shortcut ALT + 

F8), select your macro from the list.  
2. Click onRUN; 
3. Use the shortcut key if you created one (our example is CTRL +s); 
4. Use an icon on the toolbar if one has been created for the macro or 
5. Use a button on the worksheet if one has been created  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Absolute vs Relative  
If you followed the example above, run the macro a couple of times from different 

locations. For example, place your cursor in A1 and run the macro – it will select 

cells F1:G12. Place your cursor in H12 and run the macro. It will still select the cells 

F1:G12 . This is because the macro you created recorded ABSOLUTE cell references 

– the default way of recording. If you want to select a range of cells relative to 

where your cursor is at the time of recording, ensure you click on the Relative / 

Absolute icon on the Macro toolbar before commencing to record.  
 



 

 

 
 
 
 
 
 
 

MS Excel 2007 92  
 
 
 
 
 
 
 
 
 
 

Assigning buttons to macros  
Macros can be assigned to buttons or any AutoShape on the worksheet. These 

buttons will only show on the worksheet that you assign it to and therefore the 

macro will only be available to the worksheet the button is on. To assign 
a button: 

1. Make sure the FORMS toolbar is showing (right click mouse over a 
toolbar that is already showing and select FORMS from the list, or 
VIEW, TOOLBARS, FORMS) 

2. Select the BUTTON shape 
fromthetoolbar. Once you have 
clicked on the shape, go into the 
worksheet and click and drag the 
mouse until the desired size of the 
button is achieved (this can be 
edited later if necessary).  

3. The ASSIGN MACRO window 
will immediately appear. 
Select the macro being 
assigned to the button from 
the list. Click on OK.  
You will be returned to the 
Excel worksheet where you 
will see your button with 
sizing handles around it. You 
can change the text inside the 
button by dragging over the 
text and retyping.  

 

Sizing handles 
(used for 
resizing object)  
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a) To resize, hold mouse over a sizing handle and drag in orout 
 

b) To retype label drag over text, then type. If the button is not 

selected, select it by: 

 Holding down CTRL key and clicking on the button;or

 Click on the button with Right Mouse button and select

EDITTEXT.  
Do not use left mouse button to select the button as this runs the 

macro. 
c) To move the button, click and drag on the frame surrounding the 

button, avoid dragging on the sizing handles. 
5. Once you click away from the button you have created, it becomes 

active and will run the macro assigned to it when clicked on. 
 

Assigning the macro to an AutoShape 
1. Draw an AutoShape on your worksheet. 
2. Format the AutoShape in any way you like e.g. borders and patterns. 
3. Add descriptive text to the AutoShape (right Mouse click on the 

AutoShape and select ADDTEXT) 
4. Right mouse click on the AutoShape and select ASSIGN MACRO (if Assign 

Macro is not available try clicking on the frame surrounding the Auto Shape 

again, it should be made up of tiny dots, not diagonal lines.  
 
 
 
 
 
 
 
 
 
 
 
 

 

If the frame surrounding the object is 
made up of diagonal lines, click on the 
frame again so that is made up of tiny 
dots. “Assign Macro” will then be active 
in the shortcut menu  
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5. The ASSIGN MACRO window will immediately appear. Select the macro 

being assigned to the AutoShape from the list. Click on OK.  
6. When you deselect the AutoShape, it becomes active and will run the 

macro assigned to is when clicked on. 
 

Assigning a macro to an icon on a Toolbar  
Macros can be assigned to icons on an existing toolbar or on a new toolbar. This 
macro will be available whenever you open a worksheet showing that toolbar.  

1. Use either the VIEW, TOOLBARS, CUSTOMIZE command or click on any 
toolbar with the right mouse button and select the CUSTOMIZE option. 
The CUSTOMIZE dialog box will appear.  

2. Choose the COMMANDS index card and select MACROS from the 
CATEGORIES listing textbox.  
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3. Click on the CUSTOM BUTTON (the smiley face) in the COMMANDS 

window and drag and drop this icon on to the desired toolbar, in the 

desired location. 
4. Click with the Right mouse button on the icon you have just put on the 

toolbar and select the ASSIGN MACRO option from the shortcut menu. 
Select your macro from the list.  

5. Optional - to change the button image, make sure the CUSTOMIZE 
dialog box is still on the screen, then use the Right Mouse button over 
the icon you want to change, choose CHANGE BUTTON IMAGE from the 
menu. Choose a new icon.  

6. Close the CUSTOMIZE dialogue box. 
 

Viewing the Macro  
1. Once you have recorded your macro you may view it by Selecting 

TOOLS, MACRO, MACROS. The Macro Dialogue box will appear. 
2. Select your macro from the list and then click on the EDIT button 

 

Deleting a Macro 
1. Open the TOOLS, MACRO, MACROS dialogbox. 
2. Select the macro to be deleted, then click on the DELETE button.  
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LOOKUP TABLES 

 

The functions VLOOKUP and HLOOKUP enter information into a spreadsheet 

from a table made up of possible values. The result can be a value or text. The 

advantages of using VLOOKUP and HLOOKUP are: 
 They avoid the need for repetitious data;

 Cuts down on the possibility of entering data incorrectly; and

 Allows automatic updating of entries by changing the values in the look up 

table.
 

Example: Imagine having to workout staff allowances for 100 staff, eachen 

titled to are turn airfare to their home town each year. If you 

enter a value next to each staff member for the price of the 

airfare, and the airfares change (as they do), you would have to 

change each value every time the airfares changes. By using 

VLOOKUP, only the airfares in the lookup table are updated.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 1 - Airfares entered manually  
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Figure 2 - Airfares using a VLOOKUP formula – if the airfares change then only 

the amounts in column H will be changed – the amounts in column C will update 

automatically.  
VLOOKUP function (see Figure 2), looks up a value from the LEFT most column of 

a table. This function is used when your data is arranged in columns.  
HLOOKUP function looks up a value from the top row of a table. HLOOKUP is 
used when your table is arranged in rows. 

 

Syntax: 
VLOOKUP(lookup_value,table_array,col_index_num,range_lookup) 

 

HLOOKUP(lookup_value,table_array,row_index_num,range_lookup) 
 

The bold part of the formula above is required, the last bit is optional. lookup_value 

refers to a cell in the main part of your worksheet whose information also appears in 

the first column (or row if using HLOOKUP) of your table. Using Figure 2 as an 

example, the lookup value for the first staff member is cell B5 (Guwahati). This 

information is also found in the first column of the Lookup table (the table you are 

going to refer to, to get the amount of the airfare).  
The lookup value can be text, a value or a cell reference. table_array refers to the 

reference table from which you are going to get information. When referring to this  
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table you should refer to an ABSOLUTE range (in Figure 2 the table‟s range is 

$G$5:$H$16). You can also refer to a Range Name. If you give the table a range 

name, by default the cells will be absolute. Having an absolute range ensures that the 

formula always refers to the same set of cells making up the table when copying. 

 

The first column (or first row) of the table can be text, numbers or logical values. 

It doesn‟t matter if it is uppercase or lowercase. The first column (or row) should 

be in either numerical or alphabetical order; it can be sorted using the DATA, 

SORT menu 
 

col_index_num The third part of the function is asking which column of the  
reference table do you want your answer to come from. In 

Figure 2 the table is a 2-column table and we want the 

answer to be the amount of the airfare, therefore in this 

case the col_index_num would be2. 

If the col_index_num is less than 1, you will get a 

#VALUEerror.  
If col_index_num is more than the number of columns  

in the table, you will get a #REF!error. 
 

range_lookup The 4th part of the formula is optional depending on the  
answer you want. If you require an exact match, use FALSE.  
If you want an approximate match, leave this option out or  
use TRUE (they are the same). 

 

For example (refer to Figure 3), Saurav‟s home town has been changed from 

Sivasagar to Dibrugarh. The fourth part of the LOOKUP function has been made 

to say TRUE and will therefore look up an approximate match. Dibrugarh is not in 

the table of airfares therefore the formula returns the nearest match which is less 

than or equal to what is being looked up (Dibrugarh). Boko is the nearest match. 

This formula would be unsuitable in this case because hopefully the airfare to 

Dibrugarh would be nowhere near the amount of Rs. 1500. FALSE should have 

been used in the fourth part of this function.  
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Figure 3 - Finding an Approximate Match  
When TRUE is used, or the range_lookup is omitted, the VLOOKUP 

andHLOOKUP will return the largest match which is less than or equal 

to thelookup_value. 
If using FALSE and exact match is not found, a #N/A error is returned.  
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If lookup_value is smaller than the smallest value in the first column/row 

ofthe table, you will get a #N/Aerror.  
When referring to the table range, the range should be made to be 

ABSOLUTE.i.e. highlight the table (do not include headings), press F4 
until the range has “$” signs in front of column and row references.  

e.g. $G$5:$ H$16. (F4 is the shortcut key to toggle between different sorts of 
addresses – relative, absolute and a combination of the two. A way to remember 
this shortcut key is that the normal number 4 has the $ sign above it).  

Consider giving the table a range name. Using the airfare example, a 

goodname would be “Airfares”. As a default range names are made 

absolute.  
The table can be put on the same worksheet as your data however 

youshould take into account security issues. If you don‟t want just 
anyone changing the core data of the table you might wish to put the 
table on a different worksheet or even in a totally different file. 

 

Creating the VLOOKUP Function 
1. Place your cursor in the cell where the first result will be (C5). 
2. Formulas>LOOKUP & Reference>VLOOKUP 
The VLOOKUP FUNCTION ARGUMENTS dialog box showing on your Excelworksheet.  
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4. The Lookup_value is asking you to refer to a cell in the main part of 

your worksheet that has the data that also appears in the first column 

of the reference table. Using our airfare example, B5 has this 

information. B5 has the text “Guwahati”. Guwahati also appears in the 

first column of our reference table. If you can see B5 on your 

spreadsheet, click on it. This cell address will then appear in the first 

reference. (Use the COLLAPSE DIALOG icon if you can‟t see the 

spreadsheet behind the FUNCTION ARGUMENTS dialog box, or move 

the dialog box by dragging on the titlebar).  
5. Table_array is asking for the details about the table. Highlight the entire 

table, do not include any headings. When the range address appears in the 

reference area, use the F4 key to make the range ABSOLUTE (each column 

and row reference has a “$” sign in front of it); or  
If you have previously given the table a RANGE NAME, use F3 to bring 
up the PASTE dialog box, select the table name from the list.  

6. Col_index_num is asking for the number of the column in the table the 
result is to come from. In our example, the table has only 2 columns 
and the prices of airfares are in the second column, therefore type the 
number 2 in the third reference area.  

7. Range_lookup is optional (notice the text is not bold like the 
compulsory arguments). If you want an exact match, type FALSE in 
here. If you want an approximate match, leave it blank or type TRUE. In 
our example you would need an exact match.  
If you are doing the VLOOKUPS exercise, try leaving this option blank 
and then look at Row 11 and Row 16 of the example. Saurav‟s airfare 
would read Rs. 1500 – the amount someone flying to Boko would 
receive. Dibrugarh is not mentioned in the airfares table so it used the 
nearest matches –Boko. Fill the option in with”FALSE”. You will now 
have a “#N/ A” error. This will serve to draw your attention to the fact 
that Dibrugarh needs to be added into the table information.  

8. Click on OK to finish the function. If filling several cells with this 
formula, use the FILL HANDLE to drag down to the other cells.  

Note: In the example used, NEW STAFF entries should have #N/A errors. As 
soon as a new staff member and city is added, the prebuilt formula will 
immediately show the amount of airfare (if the city is mentioned in the 
table). 

 
If you are putting formulas in a worksheet where no data has yet been entered 

(such as the NEW STAFF in our example) #N/A errors will occur. This type of error 

can be „hidden‟ by using the ISNA or ISERROR function.  
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If you add new data to the table, your range address used in each formula will 

have to be changed to include the new cells of the table. If you used a range 

name this will be taken care of automatically if you ensure that the new data falls 

within the boundary of the range name – you can check by looking at the 

reference in the INSERT, NAME, DEFINE dialog box. As a hint, if you add a couple 

of rows in the middle of the table, add the new data then re-sort the first column 

of the table into alphabetical/numerical order, the new data will be confined 

within the boundaries of the range name.  
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ISNA AND ISERROR FUNCTIONS 
 

When doing IF and LOOKUP Functions (amongst others) you may be left with 

#N/A or#REF! error codes that look unsightly or “clutter” up the page. In the 

VLOOKUP example formulas have been built in for Staff not yet employed. #N/A 

errors will disappear as soon as a Home Town has been added to column B. #N/A 

errors occur if there is no information available to make the formula work.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

The ISNA and the ISERROR functions allow you to use other functions without 

returning an error. Instead you can have a “0” appear or alternatively an empty 

cell (or any text you enclose within double quotation marks). This would be 

useful, for example, when information is yet to be added i.e. you have formulas 

entered for a budget using January through to December. If the current month is 

March error codes will probably appear in April through to December cells. It 

would look better to have them blank (or with a “0”). 
 

The ISNA command avoids the #N/A code.  
The ISERROR command enables you to avoid the #N/A, #VALUE!, #REF!, #DIV/ 
0!,#NUM!, #NAME? and the #NULL codes.  
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Syntax:  
=IF(ISERROR(VLOOKUP(lookup_value,table_array,col_index_num,range_lookup)),””, 

VLOOKUP(lookup_value,table_array,col_index_num,range_lookup)) 
 

=IF(ISNA(VLOOKUP(lookup_value,table_array,col_index_num,range_lookup)),””, 

VLOOKUP(lookup_value,table_array,col_index_num,range_lookup)) 
 

Click in C5 in the workbook and follow the steps below:  
1. Highlight the formula in the formula bar (without the “=” sign). Copy this 
formula (use the copy icon or CTRL +C) 

 
 
 

 

2. In front of the VLOOKUP formula, BUT after the “=” sign, type IF(ISERROR) 
 
 
 
 

 

3. Now hit END on the keyboard to go to the end of the formula. Type ),””, (if you 

want the cell to be blank) or type ),0, (if you want a”0"). 
 
 
 
 
 

4. Paste in the formula you previously copied (use paste icon or CTRL+V). 
 
 
 

 

5. Finish off by typing a closing) 
 
 
 
 

6. Use the ENTER key to finish the function. If filling several cells with this 

formula, use the FILL HANDLE to drag down to the other cells. Those cells that 

previously had an error code should now be blank.  
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Data Validation 
 

Data validation allows you to control exactly what a user can enter into a cell. 

We can use data validation to ensure that the user chooses one of the three 

possible shipping options.  
Data validation allows you to build a powerful, fool-proof spreadsheet. Since 

users won‟t have to type in data manually, the spreadsheet will be faster to 

use, and there‟s a much lower chance that someone can introduce an error. 

Depending on what spreadsheet program you‟re using, the process of adding 

data validation will vary. 
To create the data validation rule, execute the following steps. 

1. Select the cell you want to validate. 
2. On the Data tab, in the Data Tools group, click Data Validation.  

 
 
 
 
 
 
 

3. The Data Validation dialog box will open  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

4. In the Data Validation dialog box, click the Settings tab.  
5. Click on the Allow box then select List from the drop-down list.  
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6. Click the Source box and then type the valid values separated by the 

appropriate list separator character depending on your installation( usually a 

comma “,” or semicolon “;”). For example if the cell is for a color of a car then 

you can limit the values by entering: Silver, Green, Blue.  
7. Instead of typing your list manually, you can also create the list entries by 

referring to a range of cells in the same worksheet or another worksheet in 
the workbook.  

8. To specify the location of the list of valid entries, do one of the following: 
i. If the list is in the current worksheet, enter a reference to your 

list in the Source box, for example enter: =$A$1:$A$6.  
ii. If the list is on a different worksheet, define a name for your 

list then enter the name that you defined for your list in 
the Sourcebox, for example, enter: =ValidProjects. 

Notes: 
1. Make sure that the In-cell dropdown check box is selected. Otherwise, you won‟t 

be able to see the drop-down arrow next to the cell.  
2. To specify how you want to handle blank (null) values, select or clear the Ignore 

blank check box.  
3. If your allowed values are based on a cell range that has a defined name and 

there is a blank cell anywhere in that range, selecting the Ignore blank check box 
allows any value to be entered in the validated cell. This is also true for any cells 
that are referenced by validation formulas: if any referenced cell is blank, 
selecting the Ignore blank check box allows any value to be entered in 
the validated cell. 

More Validation options:  
1. Display an input message when the cell is clicked. 

Click the Input Message tab.  
Select Show input message when cell is selected check box. 
Fill in the Title and text for the Input message.  

2. Display an error message when wrong data is entered. 
Click the Error Alert tab.  
Select Show error alert after invalid data is entered check box. Fill 
in the Title and text for the Error message.  

3. Select one of the following options for the Style box:  
Information: Display an information message. Does not prevent entry 
of invalid data. 
Warning: Display a warning message. Does not prevent entry of 
Stop : Prevent entry of invalid data. 

Tip  
If you change the validation settings for a cell, you can automatically apply your 
changes to all other cells that have the same settings. To do so 
1. Open the Data Validation dialog box. 
2. Click the Settings tab. 
3. Select the Apply these changes to all other cells with the same settings check 

box.  
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Using What-if Analysis: 
 

One of the most powerful features of Microsoft Office Excel is the automatic 

recalculation of a formula when any of the source data will change. Using these 

features we can observe change or one set of data make a reflection on another 

set of data. It is found in Data Tab.  
 
 
 
 
 
 
 
 
 
 

Goal Seek : When you know the desired result of a single formula but not the 

input value the formula needs to determine the result, you can use Goal seek 

feature inside What-if Analysis.  
 
 
 
 
 
 
 
 
 

 

Click on the cell where you have put the formula and click on Data tab > What-if 

Analysis > Goal seek. Then give the required value for the selected cell and by 

changing which cell it should obtain it. Click on OK button. The Goal Seek Status 

dialog box appears.  
 
 
 
 
 
 
 
 
 

 

Click on the OK button to keep the changes done intact.  
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Scenarios:  
Scenarios come under the heading of “What-If Analysis” in Excel. They are similar to 

tables in that you are changing values to get new results. For example, What if I 

reduce the amount I‟m spending on food? How much will I have left then? Scenarios 

can be saved, so that you can apply them with a quick click of the mouse.  
An example of a scenario you might want to create is a family budget. You can 
then make changes to individual amounts, like food, clothes, or fuel, and see 
how these changes effect your overall budget.  
We‟ll see how they work now, as we tackle a family budget. So, create the 

spreadsheet below:  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The figure in B12 above is just a SUM function, and is your total debts. The figure 

in D3 is how much you have to spend each month (not a lot!). The figure in D13 

is how much you have left after you deduct all your debts.  
With only 46 pounds spending money left each month, clearly some changes 
have to be made. We‟ll create a scenario to see what effect the various budgets 
cuts have. 

 From the top of Excel click the Data menu
 On the Data menu, locate the Data Tools panel
 Click on the What if Analysis item, and select Scenario Manager from 

the menu: 
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When you click Scenario Manager, you should the following dialogue box:  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

We want to create a new scenario. So click the Add button. You‟ll then get 

another dialogue box popping up:  
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The J22 in the image is just whatever cell you had selected when you brought up 

the dialogue boxes. We‟ll change this. First, type a Name for your Scenario in the 

Scenario Name box. Call it Original Budget.  
Excel now needs you to enter which cells in your spreadsheet will be changing. In 
this first scenario, nothing will be changing (because it‟s our original). But we still 
need to specify which cells will be changing. Let‟s try to reduce the Food bill, the 
Clothes Bill, and the Phone bill. These are in cells B7 to B9 in our spreadsheet. So 
in the Changing Cells box, enter B7:B9 

 
Don‟t forget to include the colon in the middle! But your Add Scenario box 

should look like this:  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Click OK and Excel will ask you for some values:  
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We don‟t want any values to change in this first scenario, so just click OK. You 

will be taken back to the Scenario Manager box. It should now look like this:  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Now that we have one scenario set up, we can add a second one. This is where 

we‟ll enter some new values - our savings.  
Click the Add button again. You‟ll get the Add Scenario dialogue box back up. 
Type a new Name, something like Budget Two. The Changing Cells area should 
already say B7:B9. So just click OK.  
You will be taken to the Scenario Values dialogue box again. This time, we do 

want to change the values. Enter the same ones as in the image below:  
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These are the new values for our Budget. Click OK and you‟ll be taken back to the 
Scenario Manager. This time, you‟ll have two scenarios to view:  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

As you can see, we have our Original Budget, and Budget Two. With Budget Two 

selected, click the Show button at the bottom. The values in your spreadsheet 

will change, and the new budget will be calculated. The image below shows what 

it looks like in the spreadsheet:  
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Click on the Original Budget to highlight it. Then click the Show button. The first 

values will be displayed! 
Click the Close button on the dialogue box when you‟re done.  
So a Scenario offers you different ways to view a set of figures, and allows you to 

switch between them quite easily. 
 

How to Create a Report from a Scenario  
Another thing you can do with a scenario is create a report. To create a report 

from your scenarios, do the following: 
 Click on Data from the Excel menu bar

 Locate the Data Tools panel

 On the Data Tools panel, click What if Analysis

 From the What if Analysis menu, click Scenario Manager

 From the Scenario Manager dialogue box, click the Summary button to 

see the following dialogue box: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

What you‟re doing here is selecting cells to go in your report. To change the 

cells, click on your spreadsheet. Click individual cells by holding down the CTRL 

key on your keyboard, and clicking a cell with your left mouse button. Select the 

cells D3, B12 and D13. If you want to get rid of a highlighted cell, just click 

inside it again with the CTRL key held down. Click OK when you‟ve selected the 

cells. Excel will then create your Scenario Summary:  
 
 
 



 

 

 
 
 
 
 
 

 
MS Excel 2007 115  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



 

 

 
 
 
 
 
 
 

MS Excel 2007 116 
 

ARRANGING WINDOWS IN WORKBOOKS 
 

You can open multiple workbook windows and arrange them into windows of 

varying displays so that you can view different parts of a worksheet from each 

workbook on the screen at one time.  
After you arrange windows, activate the one you want to use (if it‟s not already 
selected) by clicking it. In the case of the cascade arrangement (described below), 
you need to click the worksheet window‟s title bar, or you can click its button on 
the taskbar. 

 

Follow these steps to arrange workbook windows:  
1. Open the workbooks that you want to arrange.If you want to open at 

least two workbooks and select the worksheet in each workbook that 
you want to display.  

2. Click the Arrange All button in the Window group on the View tab.The 
Arrange Windows dialog box appears.Select the desired Arrange 
setting in the Arrange Windows dialog box.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

4. Make one of the following selections:  
 Tiled: Select this option button to have Excel arrange and size the 

windows so that they all fit side by side on the screen in the order 
in which you opened them. 
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Arrange four worksheet windows with the Tiled option.  
 Horizontal: Select this option button to have Excel size the 

windows equally and place them one above the other. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Four worksheet windows arranged with the Horizontal option.  
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Vertical: Select this option button to have Excel size the windows equally 

and place them next to each other.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Arrange four worksheet windows with the Vertical option.  
 Cascade: Select this option button to have Excel arrange and size 

the windows so that they overlap one another with only their title 

bars showing. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Four worksheet windows arranged with the Cascade option. 
 

1. Click OK.  
The workbooks are arranged on-screen based on your selection in the previous 
step.  
If you want to have Excel show only the windows that you have open in the 
current workbook, select the Windows of Active Workbook check box in the 
Arrange Windows dialog box.  
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FREEZING 
 

Freezing panes is a great help when working with large spreadsheets. Freezing 

panes makes it easier to see what numbers in cells represent. 
 

Freeze panes 
1. Click the Sales tab.  
2. In the Sales worksheet, click cell A4.  

 
 
 
 
 
 
 
 
 
 
 
 
 

 

3. Click the View tab.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

4. In the Ribbon, click Freeze Panes, then Freeze Panes.  
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5. Scroll vertically in the worksheet.The rows below the months should 

scroll.  
 
 
 
 
 
 
 
 
 
 
 

6. In the Ribbon, click Freeze Panes, then Unfreeze Panes.  
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7. Scroll vertically in the worksheet.The view should have returned to normal.  
 
 
 
 
 
 
 
 
 
 

 

8. Click the heading for column C.  
 
 
 
 
 
 
 
 
 
 
 
 
 

 

9. In the Ribbon, click Freeze Panes, then Freeze Panes. 
 

10. Scroll horizontally in the worksheet.The columns to the right of column B 

should scroll.  
 
 
 
 
 
 
 
 
 
 
 
 
 

 

11. In the Ribbon, click Freeze Panes, then Unfreeze Panes. 
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PROTECTING YOUR WORK 
 

Create a password that only allows certain users to change the worksheet or the 

entire workbook. 
1. Cell protection format 

i. The default protection for every cell is a locked cell 
ii. To see this, right click inside any cell 
iii. From the menu click on Format Cells... 
iv. In the Custom Lists window, select the Protection tab 
v. Locked is check as a default 

This will allow us to password protect our worksheet 
vi. Click the cancel button in the bottom right of the window 

 

2. Protect your worksheet  
i. On the Ribbon >select the Review tab>in the Changes group >click Protect 

Sheet 
ii. Check  the box next to Protect worksheet and contents of locked cells 
iii. In the text box under Password to unprotect sheet:, type the password 
iv. Check  the box next to both Select locked cells and Select unlocked 

cells 
v. Click the OK button 

 

3. Changing any of the data in your worksheet  
i. Once you try to change something, a window will open explaining how 

the sheet is protected from change 
ii. To change the data you need to unprotect the worksheet 
iii. On the Ribbon >select the Review tab>in the Changes group >click 

Unprotect Sheet 
iv. The password is now gone and you can edit the file 

 

4. Protect workbook  
i. It is the same thing as protecting the worksheet except this time you 

protect the entire file 
 

5. Save the file  
 
 
 
 
 
 
 
 
 

 


